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Inledning 1

Vad innehåller det här kapitlet?
• Översikt: sida 1

• Hjälp: sida 3

• Kompatibla enheter: sida 4 

• Att använda bruksanvisningen: sida 6

• Användarsäkerhet: sida 6

Översikt   

Tack för att du valt Medtronic Diabetes som din partner för att 

underlätta för dig och dina patienter att styra diabetesbehandlingen. 

Vi tror att du kan ha nytta av CareLink™ Pros banbrytande teknik och 

enkla, menystyrda användargränssnitt.

I bruksanvisningen beskrivs hur man ska använda CareLink Pro för att 

ta fram, lagra och rapportera om patienternas behandling och 

diagnostiska uppgifter. Dessutom beskriver den hur man kommer åt 

uppgifter om pumpen, mätaren och glukossensorn som patienterna 

har skickat till CareLink™ Personal, ett webbaserat behandlings-

hanteringssystem som ska användas tillsammans med CareLink Pro.
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Funktioner     

CareLink Pro är en programvara för diabetesbehandling som ska 

användas på en persondator (PC). Den har följande funktioner:

• Patientjournaler kan skapas för att lagra uppgifter, både från 

enheten och behandlingsuppgifter från deras CareLink Personal-

konto. 

• Uppgifter från insulinpumpar och blodsockermätare kan skickas till 

systemet, sparas och sedan användas för att generera rapporter.

• Den kan även samverka med CareLink Personal-systemet, så att det 

går att komma åt uppgifter om enheterna som patienterna har sparat. 

En användbar funktion om man vill ta fram aktuella rapporter mellan 

patientens kontrollbesök, eller om man vill slippa läsa av uppgifter 

från enheten under kontrollbesöken. 

• Olika behandlingsrapporter kan skapas med de uppgifter från enheten 

som sparats i patientjournalen. Rapporterna kan ge svar på frågor 

kring behandlingen som patientens respons, mönster och undantag.

• Systemet anger automatiskt när det finns nya versioner av 

programvaran som kan hämtas och installeras. På så sätt vet ni säkert 

att ni alltid har tillgång till de senaste funktionerna. 

• Det finns en hjälpfunktion som hjälper användare som inte känner till 

CareLink Pro. Hjälpfunktionen kommer med tips om de uppgifter 

patienten utför.

• Programvaran omfattar ett integrerat hjälpsystem som ger 

information om vissa punkter.

Säkerhet     

• CareLink Pro kan skyddas med ett lösenord.

• Överföringen av patientuppgifter från CareLink Personal krypteras 

med tekniken Secure Sockets Layer (SSL), som är standard inom 

branschen.

Relevanta dokument     

Denna bruksanvisning innehåller inte specifik produktinformation. 

Nedanstående dokument kan ge dig utförlig information om diverse 

produkter: 

OBSERVERA: Vad gäller
mätare från andra

tillverkare så hänvisas
till bruksanvisningarna

som följer med dessa
mätare.

• Bruksanvisningen till Paradigm Insulinpump

• Bruksanvisning om sensorfunktioner

• Bruksanvisningen till Paradigm Link blodsockermonitor

• Bruksanvisningen till ComLink
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Hjälp             

Kontakta en av följande resurser om du behöver mer hjälp med det 

här systemet. 

USA och Kanada

Medtronic MiniMed tillhandahåller ett telefonnummer för personer 

bosatta i USA och Kanada för rådgivning vid programvaruproblem. Det 

gäller från måndag till fredag, från 8:00 f.m. till 5:00 e.m. 
normaltid (tidszon) vid Stillahavskusten i Nordamerika.

Utanför USA och Kanada

För personer bosatta utanför USA och Kanada, var vänlig kontakta 

Medtronic produktsupport i ditt hemland om du behöver hjälp. 

Använd följande URL för att få tillgång till Medtronics internationella 

kontaktinformation:

http://www.minimed.com/help/contact/locations.html 

Avdelning Telefonnummer

24-timmars hjälplinje inom USA och Kanada (800) 646-4633
800-MiniMed

24-timmars hjälplinje utanför USA och Kanada 818-576-5555

MiniMed hemsida www.minimed.com
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OBSERVERA: Vissa
enheter som stöttas av

denna programvara
kanske inte finns

tillgängliga i alla länder
där programvaran har

godkänts för
användning.

Kompatibla enheter     

CareLink Pro hämtar uppgifter från följande pumpar, mätare och 

kommunikationsenheter.           

Insulinpumpar    

Medtronic MiniMed-pumpar 508

MiniMed Paradigmpumpar 511, 512, 712, 515 och 715

Paradigm REAL-tidssystem 522 och 722
522K och 722K (endast USA)

Tillverkare Blodsockermätare     

Medtronic/BD: • Paradigm Link™ blodsockermonitor
• BD Logic™

LifeScan: • OneTouch® UltraSmart®

• OneTouch® Profile® 

• OneTouch® Ultra® 

• OneTouch® Basic® 

• OneTouch® FastTake® (Euroflash i Sverige)

• OneTouch® SureStep®

Bayer: • Ascensia® BREEZE™

• Ascensia® CONTOUR™

Bayer Ascensia® DEX®-
familjen, inklusive dessa 
kompatibla mätare:

• Ascensia® DEX® 

• Glucometer® DEX® 

• Ascensia® DEX® 2

• Glucometer® DEX® 2 

• Ascensia® DEXTER-Z® II

• Glucometer® DEXTER-Z®

• Ascensia® ESPRIT® 2 

• Glucometer® ESPRIT®

• Glucometer® ESPRIT® 2

Bayer Ascensia ELITE™-
familjen, inklusive dessa 
kompatibla mätare:

• Ascensia ELITE™ XL 

• Glucometer ELITE® XL (Precision Xceed i 
Sverige)

Abbott • Precision Xtra™ 

• Abbott FreeStyle®, FreeStyle Flash™ (FreeStyle 
Mini i Sverige)
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Motsvarande enheter     

Om du vill lägga till en enhet till systemet ska du välja märke och 

modell på en lista. Om märket och modellen inte finns med på listan 

kan du hitta en motsvarande enhet i tabellen nedan.

OBSERVERA: Mätarna
kan beställas från de

respektive tillverkarna.

Beställning                             

Kontakta en av följande för att beställa Medtronic MiniMed-

produkter:

Personer bosatta i USA och Kanada

• Inom USA och Kanada: ring 1-800-646-4633 (1-800-MiniMed)

• Utanför USA och Kanada: ring +1-818-362-5958

Kommunikationsenheter                 

 Com-Station används med Medtronic MiniMed 508 
pump. (Se bruksanvisningen till Com-
Station för närmare information om den 
maskinvara som krävs.)

ComLink används med MiniMed Paradigm pump. 
(Se bruksanvisningen till ComLink för 
närmare information om den maskinvara 
som krävs.) 

Paradigm Link™ blodsockermonitor används med MiniMed Paradigm pump. 
(Se bruksanvisningen till Paradigm Link 
blodsockermonitor för närmare 
information om den maskinvara som 
krävs.)

Datakommunikationskabel används med blodsockermätare från 
andra tillverkare. Varje mätartillverkare 
bifogar en datakommunikationskabel.

Om din patient har någon av följande 
enheter

Välj den här enheten

• Bayer Ascensia® DEX® 2

• Bayer Glucometer® DEX® 

• Bayer Glucometer® DEX® 2 

• Bayer Ascensia® DEXTER-Z®

• Bayer Glucometer® DEXTER-Z®

• Bayer Ascensia® ESPRIT® 2 

• Bayer Glucometer® ESPRIT®

• Bayer Glucometer® ESPRIT® 2

The Bayer Ascensia® DEX® 

Bayer Glucometer ELITE® XL The Bayer Ascensia ELITE™ XL 
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Personer bosatta utanför USA och Kanada

• Kontakta Medtronic produktsupport i ditt hemland

Att använda bruksanvisningen   

OBSERVERA: I denna
bruksanvisning visas
exempel på skärmar.

Skärmarna i den
verkliga programvaran

kan avvika en aning
från dessa.

I ordlistan förklaras termer och funktioner. De skrivsätt som används i 

denna bruksanvisning beskrivs i nedanstående tabell.

Användarsäkerhet         

Indikationer 

CareLink Pro-systemet är avsett att användas som ett verktyg för att 

underlätta diabetesbehandling. Syftet med systemet är att omvandla 

information från insulinpumpar, blodsockermätare och system med 

kontinuerlig blodsockerövervakning till CareLink Pro-rapporter. 

Rapporterna ger information som kan användas för att identifiera 

Term/stil Betydelse

Klick tryck på den vänstra musknappen över ett objekt på 
skärmen för att välja det

Dubbelklicka tryck två gånger på den vänstra musknappen över ett 
objekt på skärmen för att öppna det

Högerklicka tryck på den högra musknappen över ett objekt på 
skärmen för att visa ett annat fönster eller en annan 
meny

Fet stil används för ett alternativ eller en väg på en meny. Till 
exempel: Patient > Ny patient

STORA BOKSTÄVER anger en knapp. Till exempel: SPARA

Kursiv stil används för namn på skärmar och fält. Till exempel: 
Skärmen rapporter

Naggad visar vägen till filer eller kataloger. Till exempel:

C:\Program Files\MM CareLink Pro

OBSERVERA: ytterligare information

OBS! varnar för en risk, som, om den inte undviks, kan leda 
till mindre eller medelsvåra skador på programvaran 
eller utrustningen.

VARNING! indikerar en möjlig risk, som, om den inte undviks, kan 
leda till dödsfall eller allvarlig personskada. Kan också 
beskriva möjliga allvarliga biverkningar och 
säkerhetsrisker.
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trender och följa dagliga aktiviteter, såsom antalet kolhydrater, 

mattider, insulindosering och blodsockervärden. 

Varningar 

• Systemet är avsett att användas av sjukvårdspersonal som har 

erfarenhet av diabetesbehandling. 

• Systemresultaten är inte avsedda att ge medicinsk rådgivning och 

man får inte sätta tillit till dem i sådant syfte. 

• Produkten ska endast användas tillsammans med de enheter som 

anges i detta dokument. (Se Kompatibla enheter, på sidan 4.)

• Patienterna ska rekommenderas att kontrollera blodsockervärdet 

minst 4-6 gånger om dagen.

• Patienterna ska uppmanas att inte ändra behandlingen utan att 

samråda med sjukvårdspersonalen.

• Patienterna ska uppmanas att fatta beslut om behandlingen utifrån 

sjukvårdspersonalens riktlinjer och resultaten av 

blodsockermätningar, inte utifrån glukossensorvärdena.

Kontraindikationer 

Denna programvara får inte användas med andra enheter än de som 

listas bland Kompatibla enheter, på sidan 4. Produkten får heller inte 

användas för behandling av andra medicinska tillstånd än diabetes.

Stäng alla aktiva program på din dator innan du öppnar de här 

programmen:

• CGMS® System Solutions™ programvara

• Solutions® Pumps & Meters programvara 

• Guardian® Solutions® programvara

• ParadigmPAL™  

• CareLink™ Personal 
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Navigera inom systemet 2

Vad innehåller det här kapitlet?
• Översikt: sida 8

• Öppna CareLink Pro: sida 8

• Arbetsområden: sida 10

• Huvudmenyfältet: sida 12

• Verktygsfält: sida 12

• Hjälpfunktionen: sida 13

• Learn More-länkar: sida 14

• Hjälpsystem: sida 14

Översikt

Läs igenom det här kapitlet och bekanta dig med CareLink™ Pros 

grafiska användargränssnitt (GUI). Användargränssnittet omfattar 

menyer, ett verktygsfält, ett navigationsfält, arbetsområden och ett 

hjälpfönster. 

Öppna CareLink Pro                  

1 Dubbelklicka på CareLink Pro-ikonen på skrivbordet.

Om kliniken kräver att du för in ett lösenord så visas 

inloggningsskärmen.

 CareLink Pro
skrivbordsikon
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a. För in ditt lösenord i Password-fältet (Lösenord). 

OBSERVERA: Lösenordet
är en tillvalsfunktion

som ställs in under
installationsprocessen.

b. Klicka på LOGIN.

Startskärmen visas.

 

2 Klicka på NEW PATIENT (NY PATIENT) om du vill starta en ny 

patientrapport. Om du vill öppna en befintlig patientrapport ska du 

klicka på OPEN PATIENT (ÖPPNA PATIENT).
OBSERVERA:Om det

visas ett meddelande
om att systemet inte är
tillgängligt innebär det

att en databas håller på
att säkerhetskopieras
eller återställas. Mer

information finns i
avsnittet Om systemet
inte är tillgängligt, på

sidan 79.

huvudmenyer

aktivt 
arbetsområdevisa/göm hjälpfönstretta fram patientlistanlägg till en ny patient

navigeringsfält

statusfält

Rapporternas
arbetsområde

Enhetens
arbetsområde

Profilen
arbetsområde



CareLink Pro™ Installeringshandbok    Navigera inom systemet      10

        

Arbetsområden     

OBSERVERA: I de andra
kapitlen i denna

bruksanvisning finns
mer information om
arbetsområdena och
om hur de används.

Om en patientrapport är öppen kan du klicka på en av knapparna i 

navigeringsfältet för att visa motsvarande arbetsområde. Använd 

dessa arbetsområden för att föra in eller välja information så att 

CareLink Pro-uppgifterna för den patienten kan utföras.

• Profil: Gör att du kan spara sådan patientinformation som namn och 

födelsedatum. Det här arbetsområdet tillåter även en länk till 

patientens CareLink Personal.

• Enheter: Gör att du kan spara information som krävs för att kunna 

avläsa en patients enheter.

• Rapporter: Gör att du kan välja parametrar och rapporter som ska 

genereras för patienten.

Innan en profil har lagts till och sparats för en patient är det bara 

arbetsområdet Profile (Profil) som är tillgängligt för den patienten. 

Innan enheter har lagts till för en patient är det bara arbetsområdena 

Profil och Devices (Enheter) som är tillgängliga för den patienten.
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Arbetsområden

Arbetsområdet enheter

Arbetsområdet profil

Arbetsområdet rapporter

Profil

Enheter

Rapporter
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Huvudmenyfältet       

Nedan visas de alternativ som finns tillgängliga genom huvudmenyn. 

Vissa av dessa alternativ kan även öppnas med tangentkombinationer 

som anges bredvid alternativet på menyn (t.ex. Ctrl+N för Ny 

patient). Det går även att använda navigationsfältet eller verktygs-

fältet för att komma till vissa alternativ på menyn.

Verktygsfält     

CareLink Pros verktygsfält gör att du snabbt kommer åt funktioner 

som används ofta. Följande knappar finns i verktygsfältet.

Knapp Namn Funktion

 Lägg till patient
Öppnar ett arbetsområde för Profil så att 
du kan lägga till en ny patientjournal till 
systemet.

Öppna patient
Öppnar tabellen Patient Lookup där du 
kan välja vilken befintlig patientjournal 
du vill visa.

Hjälp
Visar eller gömmer hjälpfönstret. Klicka 
för systemhjälp som tar hänsyn till var du 
befinner dig i systemet. 
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Patientflikar

Efter att du har öppnat en patientjournal visas en flik bredvid verk-

tygsfältet med patientens namn. När en flik är aktiv innebär det att 

en patients journal och arbetsområde är aktiva och att du kan utföra 

CareLink Pro-uppgifter för patienten.

En patientjournal kan aktiveras genom ett enkelt klick på patient-

fliken. Stäng journalen genom att klicka på klappen STÄNG på 

patientens flik.

Hjälpfunktionen     

Det finns en hjälpfunktion i hela CareLink Pro. Den öppnar ett fönster 

med hjälp och tips om handlingar som kan utföras i den del av 

systemet som är aktivt. Hjälpfönstret kan även ha länkar till >>learn 
more (lär mer). Om du klickar på dem tar länkarna dig till det 

relevanta avsnittet på onlinehjälpen för mer information. 

Standardinställningen är att hjälpfunktion är aktiverad. Det går dock 

att stänga av den när som helst.

Knappen 
STÄNG

aktiv flik inaktiv flik

Knappen stäng
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Slå av och på hjälpfunktionen      
Knappalternativ

• Klicka på GUIDE ME-knappen (HJÄLP) för att slå av eller på hjälp-

funktionen.

Menyalternativ

• Välj Help > Guide Me för att aktivera eller inaktivera funktionen.

Learn More-länkar     

Learn More-länkarna tar dig till ett liknande ämne i online-

hjälpsystemet. Det finns i hela systemet, i hjälpfönster eller i 

programvaran. Klicka på >> learn more om du inte vet hur du ska 

fortsätta eller vilka värden du ska föra in. 

Hjälpsystem     

Hjälpsystemet hjälper dig under användningen avCareLink Pro. Det 

ger information om hur uppgifterna i programvaran ska utföras. 

Gör något av det följande för att komma till hjälpsystemet:

• Välj Help> CareLink Pro Help. 

• Tryck på F1.

Hjälpknapp

learn more-länk
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Komma igång 3

Vad innehåller det här kapitlet?
• Innan du börjar: sida 15

• Öppna och stäng patientjournaler: sida 17

• Ställ in systempreferenserna: sida 18 

I det här kapitlet beskrivs hur man startar CareLink™ Pro-

programmet, öppnar och stänger patientjournaler och ställer in 

preferenser som gäller för alla patienter i systemet. 

Innan du börjar

Om det är första gången du använder CareLink Pro måste du fylla i 

dina General preferences (allmänna inställnignar, se Allmänna 

preferenser, på sidan 19). Dessa inställningar avgör hur vissa saker 

visas i programvaran och på rapporter samt hur du vill att 

systemet ska kommunicera med Internet.

Inställningarna kan göras när som helst. Det kan hända att du vill 

vänta tills du har bekantat dig med CareLink Pro-programvaran 

innan du för in de andra inställningarna.
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Primära systemuppgifter     

I tabellen nedan visas de huvuduppgifter som du förmodligen vill 

utföra första gången du ställer in och använder CareLink Pro. 

Dessutom anger den var i bruksanvisningen du kan hitta information 

om de olika uppgifterna.

Steg Var?

Bekanta dig med CareLink Pros 
gränssnitt. Kapitel 2, Navigera inom systemet

Definiera de övergripande systemval 
som kliniken ska använda.

Ställ in systempreferenserna, på 
sidan 18

Skapa profiler för alla patienter. Lägg till nya profiler, på sidan 27

Länka till patienternas CareLink 
Personal-konton.

Länka till CareLink Personal 
(alternativ), på sidan 29

Lägg till patientens pump och mätare till 
profilen. Lägga till en enhet, på sidan 40

Läs av uppgifter från patientens pump 
och mätare.

Läs av uppgifter om enheten, på 
sidan 49

Ställ in och generera rapporter för alla 
patienter.

Skapa rapporter, på sidan 53

Gör regelbundna säkerhetskopior av 
CareLink Pro-databasen.

Säkerhetskopia av en databas, på 
sidan 76

Uppdatera CareLink Pro-programvaran.
Programvaruuppdateringar, på 
sidan 75
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Öppna och stäng patientjournaler

Öppna patientjournaler         

Upp till sex patientjournaler kan öppnas samtidigt. Se Lägg till nya 

profiler, på sidan 27 om du inte har skapat några patientprofiler 

ännu.

1 Välj File > Open Patient eller klicka på knappen OPEN PATIENT 

(ÖPPNA PATIENT).

En patientlista som påminner om den följande visas.

OBS! Om du får ett
meddelande om att

alltför många
patientjournaler är

öppna ska du klicka på
OK, stänga en journal

och sedan fortsätta.

2 Sök patienter genom att föra in hela eller delar av deras namn i 

fältet Find a Patient (Hitta en patient). När den patient du sökte 

markeras ska du klicka på OPEN (ÖPPNA) och dubbelklicka på raden 

eller trycka på ENTER. Du kan även navigera igenom listan med 

piltangenterna upp och ned på tangentbordet. 

Patientens arbetsområde Devices (om inga enheter har lagts till än) 

eller Reports visas.

3 Klicka på PROFILE-knappen i navigationsfältet om du vill visa 

patientens arbetsområde Profile.

Stänga patientjournaler         

1 Kontrollera att den patientjournal du vill stänga är aktiv (fliken är 

markerad).

2 Gör något av följande:

Knappen
Öppna patient

Profilknapp



CareLink Pro™ Installeringshandbok    Komma igång      18

a. Välj File > Close Patient.

b. Klicka på knappen CLOSE (STÄNGA) på patientens flik.

c. Tryck på Ctrl-F4.

Ställ in systempreferenserna             

Dessa preferenser gäller för alla patienter i systemet. Mer 

information om preferenser som endast påverkar enskilda patienter 

finns i Bekräfta rapportinställningarna, på sidan 59.

Preferenserna visas i följande grupper:

• General (Allmänt)

– Blodsockerenheter

– Kolhydratenheter

– Kommunikation

– Felsökning
• Patient Profile (Patientprofil)

– Välj och arrangera datafälten om patientprofiler.
• Patient Lookup (Patientstruktur)

– Anpassa och ändra ordningen på de fält som visas då du väljer 
Open Patient för att ta fram en lista med patienter.

• Report Generation (Generera rapporter)

– Välj vilka datafält du vill visa då du i datatabellen väljer vad som 
ska ingå i Daily Detail-rapporten

knappen stäng
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Allmänna preferenser           
1 Välj Tools > Options. Följande fönster visas.

2 Klicka på knappen för att välja det värde du vill ha:

– Glukosenheter: mmol/l eller mg/dl

– Kolhydratenheter: gram eller utbyten

a. Om du väljer utbyten för kolhydratenheter ska du föra in 
motsvarande siffra i fältet gram motsvarar 1 utbyte.

3 Markera rutan (aktivera) eller avmarkera rutan (inaktivera) för 

följande kommunikationer:
OBS! Se till att du följer

klinikens eller
dataavdelningens

riktlinjer då du ställer
in kommunikations-

preferenserna.

– Automatically check for software updates (Automatisk 
kontroll av programvaruuppdateringar): om detta har valts 
skickas ett meddelande till alla aktiva system med CareLink Pro 
så snart det finns en uppdatering av programvaran. Användaren 
har då en möjlighet att hämta och installera uppdateringarna. 
Om du föredrar en kontrollerad distribution av uppdateringar ska 

denna ruta avmarkeras. 
– Synchronize with Medtronic CareLink™ Personal (Synkronisera 

med CareLink™ Personal): Om du vill att systemet automatiskt 
ska synkronisera patienternas CareLink Personal-uppgifter varje 
gång du öppnar deras profil ska du markera rutan Synchronize 
with CareLink Personal. Om denna ruta avmarkeras måste du 
manuellt synkronisera CareLink Personal-uppgifterna för varje 
patient.
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4 För att markera eller ta bort bocken i rutan, klicka i avsnittet 

Felsökning. Om rutan är markerad kommer programmet att spara en 

rapport med avläsningar av enheten för felsökning.

5 Klicka på OK för att spara de allmänna preferenserna. 

Preferenser för patientprofilen         

1 Välj Tools > Options. 

2 Klicka på fliken Patient Profile. Följande fönster visas.

Val av datafält        
1 Markera rutorna för att lägga till de fält du vill ha.

OBS! Förnamn och
efternamn kan inte

tas bort.

2 Avmarkera rutan om du vill ta bort ett fält från profilen.

3 Om ett fält ska vara obligatoriskt ska rutan i spalten Required 

(Obligatorisk) markeras. Alla fält som är obligatoriska måste fyllas i 

innan det går att skapa en profil.

Markera rutorna för de fält du vill ha med i profilen. Använd upp- och nedpilarna för att
lägga fälten i rätt ordningsföljd.
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Lägg till ett skräddarsytt fält     

1 Markera rutan till vänster om ett tomt skräddarsytt fält.

2 För in text så att fältet får ett namn (t.ex. kontaktperson i 

nödlägen). Det fältnamnet kommer att visas på patientprofilen.

3 Om fältet ska vara obligatoriskt ska rutan i spalten Required 

markeras.
OBS! Om du vill ta bort

ett skräddarsytt fält
från profilen ska du

avmarkera rutan
bredvid de(t) fält du vill

ta bort.

Ändra ordningen på datafälten         

• Välj det fält du vill flytta och klicka på upp- eller nedpilen för att 

flytta det. (Pilen överst och nederst flyttar fältet till den översta eller 

understa positionen på listan.) Upp- & ned-
 pilar
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Slutför preferenserna för patientprofilen

• Klicka på OK när du har fått med alla fält du vill ha, i rätt ordning.

Nu har patientprofilerna alla fält, i den ordning, som du valt.

Preferenser för Patient Lookup         

1 Välj Tools > Options. 

2 Klicka på fliken Patient Lookup. Följande  fönster visas.

Markera rutorna för att välja de uppgifter du vill ha med i tabellen Patient Lookup. 
Använd upp- och nedpilarna för att lägga kolumnerna i rätt ordningsföljd.
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Val av uppgifter som ska visas        
• Markera rutorna för att välja vilka uppgifter du vill visa, eller 

avmarkera rutorna för uppgifter du inte vill visa i tabellen Patient 

Lookup.

OBS! Förnamn och
efternamn kan inte

tas bort.

Ändra kolumnernas ordningsföljd        
• Om du vill ändra ordningsföljden på kolumnerna i tabellen Patient 

Lookup ska du välja den kolumn som ska flyttas och klicka på upp- 

eller nedpilarna.. (Pilen överst och nederst flyttar kolumnen till den 

översta eller understa positionen på listan.)

OBS! Den kolumn som
står överst på listan

Column Display Order
kommer att visas som

första kolumn i tabellen
Patient Lookup. Den

kolumn som står
nederst kommer att

visas som sista kolumn i
tabellen.

Slutför preferenserna för patient lookup

• Klicka på OK när du har fått med alla kolumner du vill ha, i rätt 

ordning.

Tabellen Patient Lookup har nu uppgifterna och kolumnerna i den 

ordning du valt.

Preferenser för rapportgenerering         
Datatabellen visas under den valda delen av rapportprocessen. Den 

här tabellen ska innehålla de uppgifter som sjukvårdspersonalen 

tycker är mest användbara för att välja datum för att ta fram Daily 

Detail-rapporter.

OBS! Mer information
om hur dessa

preferenser påverkar
datatabellen då

rapporten skapas finns i
Välja rapporttyper och
de datum som ska vara

med.

1 Välj Tools > Options. 

2 Klicka på fliken Report Generation. Följande fönster visas.

Upp- & ned- pilar
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Val av uppgifter som ska visas        

• Markera rutorna för att välja vilka uppgifter du vill visa, eller 

avmarkera rutorna för uppgifter du inte vill visa i datatabellen.

Ändra kolumnernas ordningsföljd      

• Om du vill ändra ordningsföljden på kolumnerna i datatabellen ska du 

välja den kolumn som ska flyttas och klicka på upp- eller nedpilarna. 

(Pilarna överst och nederst flyttar kolumnen till den översta eller 

understa positionen på listan.)

Markera rutorna för de uppgifter du vill ha med i datatabellen. Använd upp- och 
nedpilarna för att lägga kolumnerna i rätt ordningsföljd.

Upp- & ned-
 pilar
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OBS! Punkter som står
överst på listan Column
Order kommer att visas

som första kolumn i
datatabellen. Punkter

som står nederst
kommer att visas som

sista kolumn i
datatabellen.

Slutför preferenserna för rapportgenerering

• Klicka på OK när du har fått med alla kolumner du vill ha, i rätt 

ordning. 

Datatabellen har nu uppgifterna och kolumnerna i den ordning du 

valt.
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Profiler 4

Vad innehåller det här kapitlet?
• Innan du börjar: sida 26

• Lägg till nya profiler: sida 27

• Redigera patientprofiler: sida 28

• Radera patientuppgifter ur systemet: sida 28

• Länka till CareLink Personal (alternativ): sida 29

En profil motsvarar framsidan på en journal. Den innehåller 

patientinformation som namn och födelsedatum. En profil krävs innan 

uppgifter kan samlas in från enheten och användas för rapporter om 

behandlingen.

Profiler gör det även möjligt att lägga in en länk till patientens 

CareLink Personal-konto. Efter att länken har lagts in kan du när som 

helst hämta patientuppgifter som sparats i CareLink Personal — utan 

att patient behöver vara där.

Innan du börjar

Det kan hända att du vill anpassa patientprofilerna så att de bara 

innehåller den typ av information som du vill samla in. Läs mer om 

detta under Preferenser för patientprofilen, på sidan 20.

Dessutom måste du ha ett användarnamn och ett lösenord för att 

kunna lägga in en länk till patientens CareLink Personal-konto. 

Patienten måste vara närvarande för att tillhandahålla dessa 

uppgifter.
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Lägg till nya profiler        

Varje gång du vill lägga till en patient till CareLink Pro-systemet 

måste du börja med att fylla i en profil för patienten. 

1 Välj File > New Patient eller klicka på knappen ADD PATIENT (LÄGG 

TILL PATIENT). 

Arbetsområdet Profile visas. 
OBSERVERA:Klicka på
>>skräddarsy fälten för
att lägga till eller ändra

fält i patientprofilen. Se
Preferenser för

patientprofilen, på
sidan 20.

2 Fyll i fälten i avsnittet Patient Profile. 

3 Klicka på SAVE (SPARA).

Den nya patientprofilen läggs till i CareLink Pros databas. Ett 

bekräftelsemeddelande visas.

Knappen
Lägg till patient
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Fyll i de obligatoriska fälten

1 Om ett obligatoriskt fält inte har fyllts i då patientprofilen sparas 

visas ett meddelande bredvid det fältet. Det går inte att spara 

profilen innan det fältet har fyllts i.

2 Fyll i fältet.

3 Klicka på SAVE.

4 Klicka på OK då bekräftelsemeddelandet visas.

Redigera patientprofiler        

1 Kontrollera att patientens arbetsområde Profile är öppet. 

2 Redigera de uppgifter som ska ändras i avsnittet Patient Profile.

3 Klicka på SAVE.

Ett bekräftelsemeddelande visas.

Radera patientuppgifter ur systemet        

1 Kontrollera att patientens arbetsområde Profile är öppet. 

2 Kontrollera att det är just den patienten du vill radera. Om en 

patientprofil raderas innebär det också att alla uppgifter i CareLink 

Pros databas raderas och det kan inte ångras.

3 Klicka på >> delete patient record (radera patientjournal) ovanför 

synkroniseringsavsnittet på profilen.

Ett bekräftelsemeddelande visas.

4 Klicka på YES (Ja).
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Länka till CareLink Personal (alternativ)         

Om patienten tillåter det kan du lägga in en länk till patientens 

CareLink Personal-konto. Detta webbaserade verktyg gör att 

patienterna kan skicka och spara uppgifter som hämtats från enheten 

samt köra olika behandlingsrapporter. 

Efter att du har länkat till patientens CareLink Personal-konto kan du 

hämta de uppgifter från enheten som sparats där. Detta är praktiskt 

om du vill skapa CareLink Pro-behandlingsrapporter mellan patientens 

kontrollbesök. Dessutom innebär det att enheten sällan eller aldrig 

behöver avläsas under patientens kontrollbesök.

Om en patient inte har något CareLink Personal-konto kan du mejla 

patienten och uppmana honom eller henne att skapa ett. 

Länka till ett befintligt konto             
OBSERVERA: Patienten

måste vara närvarande
för att dessa steg ska

kunna slutföras.

1 Kontrollera att du har Internetanslutning.

2 Öppna patientens arbetsområde Profile. 

3 Kontrollera att alla obligatoriska fält i avsnittet Patient Profile är 

ifyllda.

4 Klicka på LINK TO EXISTING ACCOUNT (LÄNKA TILL BEFINTLIGT 

KONTO). 

CareLink Personals inloggningsskärm visas.
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5 Be patienten att:

a. Föra in användarnamn och lösenord.

b. Klicka på SIGN IN (ANMÄLAN).

En åtkomstsida visas, baserad på patientens 

registreringsinställningar för språk och region.

6 Be patienten att:

a. Läsa igenom användarvillkoren.

b. Klicka på rutan bredvid I agree to the Terms of Use above (Jag 
accepterar villkoren ovan) ... 

c. Klicka på GRANT ACCESS (BEVILJA ÅTKOMST).

d. Tala om för dig när sidan Thank You (tack) visas.

Ethan Drake

ABC-prov
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Du kan skriva ut användarvillkoren åt patienten genom att klicka på 

utskriftsknappen.

Nu har du en länk till den här patientens CareLink Personal-konto. Se 

Hämta uppgifter från ett länkat konto, på sidan 32.

Mejla en inbjudan            

Gör så här för att melja en inbjudan till en patient om att öppna ett 

CareLink Personal-konto:

1 Öppna patientens arbetsområde Profile. 

2 Kontrollera att alla obligatoriska fält i avsnittet Patient Profile är 

ifyllda.

Ethan Drake
ABC-prov
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3 Klicka på SEND E-MAIL INVITATION TO PATIENT (MEJLA INBJUDAN TILL 

EN PATIENT).

4 Kontrollera att Patientnamn, e-post och Språk... har fyllts i korrekt.

5 Klicka på SEND (SKICKA). 

I patientens profilstatusområde bekräftas att mejlet har skickats.

Koppla loss en patient från CareLink Personal

Du kan koppla loss en patient från CareLink Personal. Det här är 

endast möjlogt efter att en patient har blivit länkad. Det förhindrar 

CareLink Pro från att fortsätta samla in data från patientens CareLink 

Personal konto. Det påverkar inte patientens användning av deras 

CareLink Personal konto.

1 Öppna patientjournalen och du kommer till området Profiler.

2 Klicka på UNLINK ACCOUNT (koppla bort konto).

3 Klicka på Yes (Ja) för att bekräfta. Patientens profil är inte längre 

kopplad till CareLink Personal.

Statuset är ändrat från "Not linked" (inte länkad) och LINK TO 

EXISTING ACCOUNT (länka till existerande konto) samt SEND E-MAIL 

INVITATION TO PATIENT (skicka en e-mail med inbjudan till 

patienten) knapparna visas nu.

Hämta uppgifter från ett länkat konto             

Om du är länkad till en patients CareLink Personal-konto skickas alla 

nya uppgifter från det kontot automatiskt till dig varje gång du 

öppnar den patientprofilen i CareLink Pro. 
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OBSERVERA: För att
säkerställa det ska du

gå till Tools > Options >
General, och kontrollera

att rutan bredvid
“Synchronize with

CareLink Personal” är
markerad.

Följ dessa steg för att hämta en patients CareLink Personal uppgifter 

när som helst efter att du har öppnat den patientprofilen:

1 Kontrollera att patientens arbetsområde Profil är öppet och att du 

är ansluten till Internet.

2 Välj Tools > Synchronize Patient Data.

Synkroniseringsikonen på patientens flik roterar. Då ikonen stannar 

har processen slutförts.
OBSERVERA: Om

patienten inte längre
vill att

du ska kunna se
CareLink Personal-

uppgifterna visas ett
meddelande om detta.

3 Alla ytterligare uppgifter som hämtats från CareLink Personal visas i 

patientrapporterna. 

synkroniseringsikon
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Maskinvaruinställning 5

Vad innehåller det här kapitlet?
• Innan du börjar: sida 34

• Anslutning av enheter: sida 35

Det här kapitlet innehåller diagram som visar hur man ska ställa in 

patientens enhet så att din dator kan hämta uppgifter från den.

Du måste ha tillgång till patientens enhet för att kunna läsa 

uppgifter direkt från den. Däremot kan du hämta uppgifter från en 

patients CareLink™ Personal-konto, så slipper du läsa dem direkt 

från enheten.   

Innan du börjar

För att kunna läsa uppgifter direkt från en enhet måste du ha 

tillgång till patientens enhet. Dessutom måste du ha alla 

nödvändiga kablar eller andra kommunikationsenheter som behövs 

för att kunna skicka uppgifter från enheten till din dator.



CareLink Pro™ Installeringshandbok    Maskinvaruinställning      35

Anslutning av enheter              

OBSERVERA: Mer
information finns i de

instruktioner som

CareLink™ Pro visar då
du läser av enheter.

Granska översiktsdiagrammet för att få en allmän uppfattning om hur 

enheter ska ställas in för att kunna kommunicera med datorn. 

Följande diagram illustrerar specifika aspekter av enhetens 

kommunikation. 

OBSERVERA: Det här
exemplet visar hur

ComLink används för
kommunikation mellan

pumpen och datorn.

Översikt över maskinvaruinställningen               

Paradigmpump
ComLink

PC
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Diagram över maskinvaruanslutningar                                    

                           

PC-anslutningar

USB
port

Seriell
port
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anslut till en
seriell port på

datorn

ComLink som används med pumpar i Paradigmserien.

Extra komponenter

Com-Station som används med MiniMed 508-pumpar och för genommatning av mätaren
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OBSERVERA: På bilden
visas några av de

många mätare som
stöttas.

Mätaralternativ

Paradigm Link™
BD Logic™

Elite™ XL

till USB-port
till seriell port

till seriell port

25-9
stiftadapter
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Enheter 6

Vad innehåller det här kapitlet?
• Innan du börjar: sida 40

• Lägga till en enhet: sida 40

• Gör en enhet aktiv eller inaktiv: sida 46 

• Läs av uppgifter om enheten: sida 49

Information du behöver för att läsa av en patients enhet (märke, 

modell, serienummer, etc.) lagras i arbetsområdet Devices 

(Enheter). Den behöver alltså inte anges varje gång du läser av 

uppgifter från enheten. 

Enheter i arbetsområdet Enheter sparas på en av de två listorna—

Aktiva enheter eller Inaktiva enheter. När du lägger till en enhet 

hamnar den automatiskt på listan Aktiva enheter. Du kan bara läsa 

av uppgifter från enheter som visas på listan Aktiva enheter. De är 

sannolikt de enheter som din patient använder. 

Andra enheter som patienten kan ha, men som han eller hon inte 

använder just nu, kan sparas på listan Inaktiva enheter. Det gör 

att informationen sparas och att dessa enheter kan aktiveras när 

det behövs.
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Innan du börjar

Innan du kan öppna arbetsområdet Enheter för en patient måste han 

eller hon ha en profil som sparats i systemet. Se Kapitel 4, Profiler.

För att du ska kunna lägga till en enhet eller läsa uppgifter direkt från 

den måste den kommunicera med datorn. I Kapitel 5, 

Maskinvaruinställning beskrivs hur du ska ställa in enheter så att de 

kan kommunicera med datorn.

Lägga till en enhet         

För att du ska kunna lägga till en enhet till en patientjournal måste 

enheten kommunicera med datorn så att anslutningen kan testas.

Däremot kan du hämta uppgifter från en patients CareLink Personal-

konto för en enhet som inte lagts till ännu. Sådana enheter läggs 

automatiskt till när uppgifter synkroniseras mellan CareLink Personal 

och CareLink Pro.

OBSERVERA: Det kan
bara finnas en aktiv

pump per patient. Om
du lägger till en ny

pump flyttas den
tidigare till den
inaktiva listan.

Lägga till en pump          

1 Kontrollera att den pump du lägger till är inställd så att den kan 

kommunicera med datorn. (Se Kapitel 5, Maskinvaruinställning för 

instruktioner om anslutningen.)

2 Klicka på patientens flik. Eller dubbelklicka på patientens namn i 

tabellen Patient Lookup.

3 Klicka på knappen DEVICES. Patientens arbetsområde Devices visas.
knappen ENHETER
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4 Klicka på ADD DEVICE (LÄGG TILL ENHET).

5 Välj Insulin Pump (insulinpump). Guiden Add Insulin Pump visas.

OBSERVERA:
Pumpmodellen anges på

pumpens baksida eller
på pumpstatusskärmen.

6 Välj rätt knapp för den aktuella pumpmodellen. 

7 Klicka på NEXT (NÄSTA). Sidan med Serial Number (serienummer) 

visas.
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OBSERVERA: Ett
felmeddelande visas om

du för in fel
serienummer. Titta på

exemplen på den här
sidan och kontrollera

att du har fört in
samma uppgifter som
på pumpens baksida.

För in de sex tecknen på
nytt om det behövs.

8 Använd exemplen på den här sidan för att hitta igen serienumret på 

den pump du ska lägga till. (Om du behöver mer hjälp för att hitta 

numret kan du klicka på >>learn more.) För in de sex tecknen i 

fältet Pump serial number (Pumpens serienummer).

9 Klicka på NEXT. Sidan med Communication Options 

(kommunikationsalternativ) som påminner om den följande visas.

10 Klicka på pilen Choose Port (välj port) och välj den port som ansluter 

ComLink, Paradigm Link eller Com-Station till din dator. Om du inte 

är säker på vilken port det är ska du välja Auto Detect (or USB). 

11 Klicka på NEXT. Sidan med Test Connection (Testanslutningar) visas.
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12 Följ enhetens instruktioner och klicka på TEST.

Ett meddelande visas för att ange om anslutningen lyckades eller 

inte. Om den lyckades ska du gå vidare till nästa steg. 
OBSERVERA: Det här
testet läser inte av

några pumpuppgifter
utan bekräftar bara att

kommunikationen
mellan pumpen och

datorn fungerar.

Om den inte fungerar ska du kontrollera att maskinvaran mellan 

enheten och datorn har anslutits på rätt sätt. Klicka även på BACK 

(tillbaka) på sidorna i guiden för att kontrollera att du fört in rätt 

uppgifter om enheten.

13 Klicka på DONE (färdig).

Pumpen har lagts till på patientens lista med Active Devices (aktiva 

enheter).
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Lägga till en mätare          

1 Klicka på patientens flik. Eller dubbelklicka på patientens namn i 

tabellen Patient Lookup.

2 Kontrollera att den mätare du lägger till kommunicerar med datorn. 

(Se Kapitel 5, Maskinvaruinställning för instruktioner om 

anslutningen.)

3 Klicka på DEVICES (enheter). Patientens arbetsområde Devices visas:

4 Klicka på knappen ADD DEVICE (lägg till enhet).

5 Välj Blodsockermätare. Guiden Add Blood Glucose Meter (Lägg till 

blodsockermätare) visas.

6 Klicka på knappen för att ange märket på mätaren.
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7 Klicka på NEXT. Sidan Meter Brand (mätarmodell) visas (denna sida 

ser olika ut beroende på mätarens tillverkare).

8 Klicka för att välja modellen på den mätare du lägger till. 

9 Klicka på NEXT. Sidan med Communication Options visas.

OBSERVERA: Det går
bara att välja de
alternativ som är

giltiga för den mätare
du lägger till.

10 Klicka på pilen Choose Port (välj port) och välj den port som ansluter 

ComLink eller Paradigm Link till din dator. Om du inte är säker på 

vilken port det är ska du välja Auto Detect (or USB). 

11 Klicka på NEXT. Sidan med Test Connection visas.
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12 Följ mätarens instruktioner och klicka på TEST.

Ett meddelande visas för att ange om anslutningen lyckades eller 

inte. Om den lyckades ska du gå vidare till nästa steg. 

Om den inte fungerar ska du kontrollera att maskinvaran mellan 

enheten och datorn har anslutits på rätt sätt. Klicka även på BACK 

(tillbaka) i guiden för att kontrollera att du fört in rätt uppgifter.

13 Klicka på DONE (färdig).

Mätaren har lagts till på patientens lista med Active Devices.

Gör en enhet aktiv eller inaktiv      

Patientenheterna kan flyttas mellan listorna Active Devices och 

Inactive Devices efter behov. En enhet måste vara aktiv för att man 

ska kunna läsa av uppgifter från den. 

Du kan ha så många mätare du vill på listan med Active Devices, men 

bara en pump. Kontrollera att du verkligen vill inaktivera den aktuella 

pumpen innan du lägger till en ny.

Inaktivera en enhet               
1 Klicka på patientens flik. Eller dubbelklicka på patientens namn i 

tabellen Patient Lookup.

2 Klicka på DEVICES (enheter). Patientens arbetsområde Devices visas.
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OBSERVERA: Enheterna
kan finnas med på

listan med ett
motsvarande namn. Se

Motsvarande enheter, på
sidan 5.

3 Klicka på >> make this device inactive (inaktivera den här 
enheten) under den enhet du vill inaktivera.

Enheten flyttas till listan med Inactive Devices.

Återaktivera en enhet                
1 Klicka på patientens flik. Eller dubbelklicka på patientens namn i 

tabellen Patient Lookup.

2 Klicka på DEVICES (enheter). Patientens arbetsområde Devices visas.
OBSERVERA: Enheterna

kan finnas med på
listan med ett

motsvarande namn. Se
Motsvarande enheter, på

sidan 5.

3 Klicka på >> activate this device (aktivera den här enheten) under 

den enhet du vill aktivera.

Enheten flyttas till listan med Active Devices.

Radera en enhet               
Gör så här för att radera en enhet och dess uppgifter från 

arbetsområdet Devices och CareLink Pro-systemet:

1 Klicka på patientens flik. Eller dubbelklicka på patientens namn i 

tabellen Patient Lookup.

2 Klicka på DEVICES (enheter). Patientens arbetsområde Devices visas.
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OBSERVERA: Enheterna
kan finnas med på

listan med ett
motsvarande namn. Se

Motsvarande enheter, på
sidan 5.

3 Kontrollera att enheten finns med på listan med Inactive Devices. 

Om den inte gör det ska du klicka på >> Inactive Devices på den 

lista där den står nu.

4 Klicka på >> delete this device (radera den här enheten) under den 

enhet du vill radera.

Ett bekräftelsemeddelande visas:

5 Klicka på YES (Ja). 

Enheten och dess uppgifter tas bort från arbetsområdet Devices och 

från CareLink Pro-systemet. Uppgifter från den här enheten kan inte 

längre användas i rapporter.
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Läs av uppgifter om enheten            

Ett sätt att få uppgifter från enheten är att länka till patientens 

befintliga CareLink Personal-konto. (Se Länka till CareLink Personal 

(alternativ), på sidan 29.) Ett annat sätt är att läsa av dem direkt från 

enheten, på det sätt som beskrivs i detta kapitel. 

Uppgifter från patientens enhet kan läsas av CareLink Pro om enheten 

finns med på listan med Active Devices och om den kommunicerar 

med datorn. Efter att du har fått fram de här uppgifterna kan du 

använda dem för att skapa rapporter som underlätta bedömningen av 

patientens behandling. (Se Kapitel 7, Rapporter om du vill läsa mer 

om rapporter.)

Systemet hämtar följande typer av uppgifter från insulinpumpen då 

enheten läses av:

• Olika inställningar på pumpen, som alarmläget, signalvolymen och 

tiden.

• Basaldoser insulin doseras

• Bolusinsulintyper och mängder som doserats

• Information från Bolusguiden

• Primingmängder

• Stopperioder

• Sensorglukosvärden under en viss tid

Systemet samlar in uppgifter om blodsockret från blodsockermätaren 

då enheten avläses.

VARNING: Annulera eller slutför alla temporära basaldoser eller aktiva bolusar och radera 
alla aktiva alarm. Pumpen stoppas under avläsningen. Kontrollera att pumpen startar igen 
efter att avläsningen har slutförts.

VARNING! Använd inte fjärrkontrollen då pumpen avläses. 

Om pumpbatteriet nästan är tomt skickar pumpen inte några uppgifter till datorn. Byt ut 
batteriet om statusen anger att batteriet är nästan tomt.    
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1 Klicka på patientens flik. Eller dubbelklicka på patientens namn i 

tabellen Patient Lookup.

2 Kontrollera att patientens enhet kommunicerar med datorn. (Se 

Kapitel 5, Maskinvaruinställning.)

3 Klicka på DEVICES. Patientens arbetsområde Devices  visas.

OBSERVERA: Enheterna
kan finnas med på

listan med ett
motsvarande namn. Se

Motsvarande enheter, på
sidan 5.

4 Lokalisera den enhet du vill hämta uppgifter från i listan Active 

Devices, och se till att uppgifterna under Choose port (välj port) är 

korrekta.

– Klicka på pilen Amount of Data (mängd uppgifter) för pumpar och 
ange hur många pumpuppgifter du vill att CareLink Pro ska läsa 
av.

5 Klicka på motsvarande knapp READ DEVICE (läs av enhet).

6 Följ specifika instruktioner för enheten och klicka på OK.

7 CareLink Pro visar en förloppsindikator som anger hur stor del av 

avläsningen som har slutförts.

Om du klickar på CANCEL då enheten avläses visas ett 

bekräftelsemeddelande:
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– Klicka på YES för att annulera. 

– Klicka på NO om du vill fortsätta att läsa av uppgifterna.

När systemet har avslutat avläsningen visar ett 

bekräftelsemeddelande som påminner om det följande:

8 Klicka på OK. Se vid behov bruksanvisningen till pumpen för att 

starta den igen.

Se Kapitel 9, Felsökning för närmare anvisningar om CareLink Pro inte 

kan hämta några uppgifter från enheten.
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Rapporter 7

Vad innehåller det här kapitlet?
• Innan du börjar: sida 52

• Skapa rapporter: sida 53

• Om rapporter: sida 63

• Exportera data: sida 72

CareLink™ Pros arbetsområde rapporter gör att du kan omforma 

uppgifter som hämtats från enheten till kliniskt användbar 

information. I Om rapporter, på sidan 63 anges vilka slags rapporter 

du kan sammanställa. 

Rapporter kan genereras på skärmen, skickas direkt till en skrivare 

eller sparas som TIFF- eller PDF-filer som du kan bifoga till en 

Electronic Medical Record (EMR). Du kan generera flera olika slags 

rapporter under en enda handling.

De uppgifter som visas i dessa rapporter hämtas från patientens 

enheter, från deras CareLink Personal-konto eller från både och. 

Innan du börjar

Om du vill visa uppgifterna från en viss tidsperiod i en rapport måste 

du hämta uppgifterna om den perioden från patientens enhet. Det 

kan även hända att patientens enhet måste anslutas till datorn för att 

hämta aktuella uppgifter innan det går att skapa rapporter.

Kontrollera uppgifterna under steget Verify Report Settings (bekräfta 

rapportinställningar) innan du skapar en rapport. Där kan du 
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finjustera en rapport så att du får fram just de patientuppgifter som 

du vill ha.

Skapa rapporter   

I de följande avsnitten beskrivs de steg som du måste genomgå då du 

skapar en eller fler rapporter.

Öppna arbetsområdet Rapporter      

1 Klicka på patientens flik. Eller klicka på knappen OPEN PATIENT och 

dubbelklicka på namnet.

Arbetsområdet Reports (Rapporter) visas.
OBSERVERA: Klicka på

SYNC DATA för att
säkerställa att du får

de senaste uppgifterna
om enheten från

patientens CareLink
Personal-konto.

Välja rapporteringsperiod        

OBSERVERA: Den
längsta period du kan

välja är 12 veckor.

1 Om du vill ändra hur pass lång tid som visas i rapporten/rapporterna 

ska du klicka på pilen Duration och välja tidslängd.

2 Start- och slutdatum ställs in automatiskt, om du inte väljer 

alternativet custom date range (anpassa datumen). 
OBSERVERA: Om du

väljer en tidsperiod
som är längre än den
längsta tillåtna visas

ett felmeddelande.
Ändra tidslängden eller

datumen.

Om du vill ställa in datumen själv ska du klicka på pilarna för Start 

Date (Startdatum) eller End Date (Slutdatum) och sedan välja 

månad, datum eller år. 

Kalender

Kalenderområdet i arbetsområdet Reports visar ett fönster på tre 

månader för rapportering av information. Där listas enheter och 

dessutom visas det hur mycket uppgifter det finns om enheten för de 

Knappen
Öppna patient
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angivna tre månaderna. Dessutom anges rapporteringsperiodens 

längd för de angivna tre månaderna. 

Överlappningar mellan uppgifter från enheten och rapporterings-

perioden innebär att det finns uppgifter för några eller alla de 

rapporteringsperioder som visas.

Kalenderområdet visar inledningsvis de senaste tre månaderna. Om 

du vill se andra månader ska du klicka på piltangenterna i början 

eller slutet av perioden.

Välj uppgifter som ska finnas med       

1 Om patienten har en BG mätare som är länkad till deras pump, klicka 

för att välja ett av de följande alternativen för rapportering av 

mätaruppgifterna: 

– lagrade i pumpen: Fördelar med det här alternativet är bland 
annat att du bara behöver läsa av uppgifter från patientens 
pump, blodsockervärdena tidsstämplas av pumpen och värdena 
kopplas direkt till den bolusberäkning som använts. En nackdel är 
att om det uppstår kommunikationsproblem mellan pumpen och 
den länkade mätaren så kan det hända att blodsockervärdena för 
den perioden inte rapporteras. Dessutom kan det, om patienten 

uppgifter om enheten
rapporteringsperiod

kalender
månad

Överlappning mellan uppgifter från enheten 
och rapporteringsperioden

piltangenter
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har en MiniMed Paradigmpump äldre än 522/722, hända att de 
blodsockervärden från Bolusguideberäkningarna som inte lett till 
förändringar inte rapporteras.

– lagrade i länkmätaren/arna: Fördelen med det här alternativet 
är att alla värden som sparats i den länkade mätaren rapporteras. 
Nackdelen är att du måste kontrollera att pumpen och mätarens 
klockor var synkroniserade för att kunna samordna uppgifter från 
mätaren och pumpen. Det kan alltså hända att du måste läsa av 
uppgifter från pumpen och den länkade mätaren separat.

2 Markera rutan bredvid enheten om du vill att uppgifter från enheten 

ska tas med i rapporterna. 

Det går inte att lägga till enheter som undantogs vid valet under steg 

1. Om du vill ändra detta ska du välja det andra länkade mätar-

alternativet.

3 Avmarkera rutan bredvid enheten om du inte vill att uppgifter från 

den enheten ska tas med i rapporterna. 

Det går inte att avmarkera enheter som togs med vid valet under 

steg 1. Om du vill ändra detta ska du välja det andra länkade 

mätaralternativet.

Välj källa för BS-uppgifter



CareLink Pro™ Installeringshandbok    Rapporter      56

Kontrollera uppgifter från enheten        

1 Se efter i kalenderområdet i arbetsområdet Reports om 

rapporteringsperioden överlappar uppgifter från enheten.

2 Om det finns överlappningar för hela rapporteringsperioden finns det 

uppgifter för din(a) rapport(er). I så fall kan du klicka på NEXT och 

gå till Bekräfta rapportinställningarna, på sidan 59.

3 Om det inte finns någon överlappning, eller om överlappningen inte 

är tillräcklig, finns det några alternativ:

– Anpassa rapporteringsperioden (se Välja rapporteringsperiod, 
på sidan 53).

– Hämta ytterligare uppgifter från enheten (se Hämta ytterligare 
uppgifter från enheten (alternativ), på sidan 57).

En markering vid en enhet innebär att uppgifter från den enheten tas med i 
rapporterna

Överlappning mellan uppgifter från enheten och 
rapporteringsperioden
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Hämta ytterligare uppgifter från enheten (alternativ)       

1 Klicka på knappen READ DEVICE (avläs enheten) som hör till en viss 

enhet om du vill ha mer uppgifter från den.

Fältet för avläsning av enheten visas.

VARNING: Annulera eller slutför alla temporära basaldoser eller aktiva bolusar och radera 
alla aktiva alarm. Pumpen stoppas under avläsningen. Kontrollera att pumpen startar igen 
efter att avläsningen har slutförts.

VARNING! Använd inte fjärrkontrollen då pumpen avläses. 

Om pumpbatteriet nästan är tomt skickar pumpen inte några uppgifter till datorn. Byt ut 
batteriet om enhetens statusskärm anger att batteriet är nästan tomt.    

2 Kontrollera att uppgifterna i fältet Choose port är de rätta för den 

här enheten. 

Om du vill ändra inställningen ska du klicka på pilen för fältet och 

välja en annan inställning.

3 Kontrollera att enheten är ansluten till din dator. 

4 Om enheten är en pump kan du specificera hur många uppgifter du 

vill ha från den. Klicka på pilen Amount of Data (mängd uppgifter) 

och välj en mängd.
OBSERVERA: Om du

väljer All available data,
(alla tillgängliga
uppgifter) läser

systemet av alla
uppgifter

från pumpen. Därmed
skrivs alla dubbla

uppgifter i systemet
över.

5 Klicka på READ DEVICE. Ett meddelande som det följande visas.

6 Följ instruktionerna och klicka på OK. 

Förloppsindikatorn för avläsning av enheten visas.

list för avläsning av enheten

knapp för AVLÄSNING AV ENHETEN
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Du kan när som helst annulera avläsningen genom att klicka på 

CANCEL.

När avläsningen har slutförts visas ett meddelande som det följande.

7 Klicka på OK.

Nu bör uppgifterna från enheten överlappa rapporteringsperioden.

8 Klicka på NEXT överst i arbetsområdet Reports.

Steget för bekräftelse av rapportinställningarna visas. Det gör att du 

kan kontrollera att inställningarna för den här patienten är korrekta 

innan du kör rapporterna.

förloppsindikatorn för avläsning av enheten

tidslinje

måltidsperiod
fält för redigering av måltidsperioderna

läggdags och uppvakning
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Bekräfta rapportinställningarna         

1 Kontrollera att inställningarna av blodsockermålet är korrekta. För 

in de rätta värdena eller klicka på pilarna upp eller ned i fälten Low 

eller High för att höja eller sänka värdena.
OBSERVERA: Du kan ha

upp till fem
måltidsperioder.

Standardinställningen
är frukost, lunch och

middag.

2 Klicka på ADD MEAL (lägg till måltid) om du vill lägga till en ny period 

för måltidsinställningarna. Klicka var som helst på tidslinjen inom en 

av måltidsperioderna för att redigera en befintlig måltidsperiod.

Fönstret för redigering av måltidsperioderna öppnas.

3 För in text eller klicka på pilarna för att välja de inställningar du vill 

ha.
OBSERVERA: Om du

bara vill använda
inställningarna för den

här måltiden ska du
avmarkera rutan

bredvid Use these
parameters for all of this
patient’s meals (Använd

dessa parametrar för
alla den här patientens

måltider).

– Meal Name: det namn du vill ge måltidsperioden.

– Meal Time Period: timmar då måltiden intas.

– Pre-Meal BG Target (mg/dl or mmol/l): lägsta och högsta 
gränsvärdena för patientens blodsockervärde före måltiden.

– Pre-Meal Analysis Period: hur lång tid innan måltiden som 
blodsockervärdet analyseras för rapporten. Mätarvärdena från 
den här tiden används i detaljerade rapportanalyser.

– Post-Meal BG Target (mg/dl or mmol/l): lägsta och högsta 
gränsvärdena för patientens blodsockervärde efter måltiden.

– Post-Meal Analysis Period: hur lång tid efter måltiden som 
blodsockervärdet analyseras för rapporten. Mätarvärdena från 
den här tiden används i detaljerade rapportanalyser.

OBSERVERA:
Måltidsperioder kan

inte överlappa
varandra, men start-
och slutlinjerna kan

gränsa till varandra.
Måltidsperioderna

måste vara minst 60
minuter långa.

Du kan ändra längden på en befintlig period för måltider, uppvakning 

och läggdags genom att klicka på start- eller slutlägena och sedan 

dra perioderna längs tidslinjen. 

Redigering av måltidsperioder

visningsruta

Gör att du kan använda samma 
inställningar för alla patientens 
måltider
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4 Om du vill använda de här måltidsinställningarna för alla patientens 

måltider ska du markera rutan bredvid Use these parameters for all 

of this patient’s meals.

5 Klicka på SAVE efter att du har skapat eller redigerat en 

måltidsperiod.

6 Ta bort en måltidsperiod genom att klicka på DELETE MEAL. Klicka på 

DELETE när du uppmanas att bekräfta.

7 CareLink Pro kommer ihåg dessa inställningar för patienten nästa 

gång du kör en rapport för honom eller henne. Klicka på SAVE 

SETTINGS för att spara dem för den här patienten.

8 Klicka på NEXT överst i arbetsområdet Reports. 

I det här steget kan du välja och generera rapporter. Du kan välja en 

lista med rapporttyper eller en datatabell som hjälper dig att välja 

att ta med eller utelämna uppgifterna från vissa dagar i Daily Detail-

rapporterna. 

välj start- eller slutläge, dra längs och släpp på tidslinjen

tidslinje

markörer för mätaravläsningar
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OBSERVERA: Klicka på
>>customize columns om

du vill ändra hur
datatabellen visas. Se

Preferenser för
rapportgenerering, på

sidan 23.

Välja rapporttyper och de datum som ska vara med          

1 Markera rutan bredvid de rapporter du vill ska ingå i rapport-

uppsättningen.

2 Om uppgifter har lästs från pumpen mer än en gång under 

rapporteringsperioden kan det finnas flera snabböverblickar över 

pumpinställningarna: 

a. Kontrollera först att rutan bredvid Pump Settings Snapshot har 
markerats. 

b. Klicka sedan på pilen i datumfältet och välj en av snabb-
överblickarna.

Om fältet är skuggat finns det inga snabböverblickar tillgängliga för 

rapporteringsperioden.

3 Bläddra igenom datatabellen för att granska den tillgängliga Daily 

Detail-rapportinformationen. 

– Du kan sortera uppgifterna i varje kolumn. Klicka på kolumn-
rubriken för att sortera uppgifterna i stigande ordning. Klicka på 
rubriken igen för att sortera uppgifterna i fallande ordning.

OBSERVERA: Om det
inte finns några

uppgifter för ett visst
datum går det inte att

välja det.

4 Markera rutan vid datatabellraderna för de datum du vill ha en Daily 

Detail-rapport över. 

– Du kan ta med eller ta bort alla datum för Daily Detail-rapporter 
genom att markera eller avmarkera rutan över alla markerings-
rutor för datum i datatabellen.

Datatabell
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Generera rapporter                                

1 Efter att du har bekräftat valen för rapporter ska du klicka på 

GENERATE REPORTS överst i arbetsområdet Reports

En lista med alternativ.

2 Välj hur du vill förhandsvisa, skriva ut eller spara rapporter.

Om du väljer Preview (förhandsvisning), visas fönstret Preview.

3 Klicka på pilarna för att navigera genom rapporter på flera sidor.

4 Klicka på någon av de andra knapparna överst i fönstret Preview för 

att spara eller skriva ut rapporterna.

5 Stäng fönstret genom att klicka på knappen CLOSE PREVIEW (stäng 

förhandsvisning) i fönstrets övre högra hörn.Knappen STÄNG
PREVIEW (stäng

förhandsvisning)
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Om rapporter        

I det här avsnittet ges en allmän beskrivning av de olika rapporterna. 

Mer information om rapportkomponenterna och provrapporter finns 

med i Report Reference Guide (guiden för referensrapporten). Du 

kommer till Report Reference Guide genom CareLink Pro-

programvaran:

1 Help > View Report Reference Guide (PDF). 

2 Välj ett språk för Report Reference Guide.

CareLink Pro-rapporterna har följande gemensamt:

OBSERVERA: Om
rapporteringsperioden
är längre än 14 dagar

består rapporten av
flera sidor.

• Rubrik — I rubriken finns information som identifierar rapporten, som 

rapportens namn, patientens namn och varifrån uppgifterna kommer.

• Kolhydrater och blodsockervärden — Kolhydratenheterna visas 

kursivt och blodsockervärdena visas i fetstil i kurvor och tabeller.

• Helguppgifter — Helgdagarna är i fetstil så att det går lätt att hitta 

dem.

• Symbolförklaringar — En lista med symboler visas längst ned på varje 

rapport. Även om symbolerna används i flera olika rapporter så är 

symbolförklaringarna unika för varje rapport.

Översiktsrapport        

Översiktsrapporten återger patientens dagliga blodsockervärden och 

genomsnitt grafiskt, inklusive uppgifter per timme som visar 

patientens värden i förhållande till måltider och sovtider. Dessutom 

ingår statistik om patientens blodsockervärden och insulindosering. 

Rapporten ger dig insikt i nivån och kvaliteten på patientens 

glykemiska kontroll. Dessutom visar den hur kontrollen varierar under 

en genomsnittlig dag och för hela rapporteringsperioden.
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Översiktsrapporten hjälper dig att lösa vissa viktiga frågor om 

patientens behandling:

• Vad har patienten för blodsockervärde vid läggdags och uppvakning?

• Finns det något mönster i hur patientens blodsockervärde reagerar 

vid samma tidpunkt under en period på flera dagar?

• Har du tillräckligt med uppgifter för att kunna göra en klinisk 

bedömning?

• Är patientens blodsockervärde lågt eller högt före eller efter 

måltiderna?

• Sjunker patientens blodsockervärde till målområdet efter två-fyra 

timmar efter en måltid?

• Doserar patienten mer eller mindre insulin jämfört med den mängd 

som rekommenderas av bolusguiden?

1

Kurva för dagligt blodsockervärde

Den här kurvan hjälper dig att fastställa hur din patient hade det 

under en viss dag. Kurvan visar dagliga totalvärden för antalet 

kolhydratsenheter som patienten åt och för antalet insulinenheter 

som doserats. Den visar också hur många mätaravläsningar som 

genomförts. 

1

3 4

2

5
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Dessutom visar rapporten de enskilda mätaravläsningarna för varje 

dag. Den anger om patientens genomsnittsvärde låg inom eller 

utanför målområdet. Om det finns sensoruppgifter tillgängliga för en 

viss dag visas det med en sensorikon.

2

24-timmars överliggande blodsockerkurva

OBSERVERA: Inga
sensoruppgifter finns

med på den här kurvan,
den anger bara om det

finns sensoruppgifter
eller inte för en viss

dag.

Kurvan visar alla mätarvärden för de dagar som ingår i 

översiktsrapporten. De läggs över varandra, timme för timme, under 

24 timmar. Det gör att du snabbt kan se om det finns några mönster 

för patientens värden under vissa tidpunkter på dagen.

3

Blodsockerkurva från läggdags till uppvakning

I den här kurvan kan du se vad som händer med patientens blod-

sockervärden under natten. Den går från det sista blodsockervärdet 

på en dag fram till det första värdet för nästa dag. (Detta stämmer 

om det finns värden tillgängliga för den angivna läggdagstiden och 

den angivna uppvakningstiden.)

4

Kurva för överliggande blodsockervärde vid måltider

I de här tre kurvorna anges mätarvärdena före, under och efter 

måltidsperioderna. De visar vad som händer med patientens blod-

sockervärde omkring måltiderna. Dessutom anges det genomsnittliga 

antalet kolhydrater som ätits och den genomsnittliga mängd insulin 

som doserats för varje måltid.

5

Statistiktabell

I den här tabellen visas totalvärden, genomsnitt, procenttal och 

mängder per dag för vissa händelser. Den presenterar uppgifter som, 

om de används tillsammans med kurvorna, ger en detaljerad bild av 

kvaliteten på patientens kontroll. 

Responsrapport        

Den här rapporten presenterar uppgifter som beskriver det patient-

beteende som är relevant för behandlingen. Den besvarar frågan "Har 

jag tillräckligt många uppgifter?" Dessutom besvarar den frågan 

sensorikon
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"Gjorde patienten de rätta sakerna så att det vore värdefullt att 

generera andra rapporter samtidigt?" Den anger om du kanske måste 

prata med patienten om hur han eller hon sköter sin diabetes.

Följande typer av beteende presenteras i rapporten:

• Hur ofta mäter de blodsockervärdet?

• Hur länge använder de sensorn (om de har en sådan)?

• Hur pass ofta använder de funktionen Bolusguide?

• Hur ofta byter de infusionsset?

• Vilken var deras primingvolym?

• Hur länge var de i stoppläget?

1

Rapporten presenteras som en tabell. Överst finns rubriker som 

överensstämmer med en av beteendetyperna.

2

Till vänster visas de datum du valt att visa för den här rapporten. 

Siffrorna i kolumnerna anger antingen totalvärdena eller tidslängden 

för varje dag.

3

Sammanfattningsraden, som visas längst ned, visar genomsnittet per 

dag. Undantaget är att Pump Suspend-sammanfattningen visar hur 

länge pumpen var stoppad.

2
1

3
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Loggboksrapport        

Loggboksrapporten ger en sammanfattning varje timme för alla dagar 

under rapporteringsperioden. Varje sida innehåller upp till 14 dagar. 

Om rapporteringsperioden överstiger 14 dagar genereras extra sidor. 

Patientens låga värden (under målvärdet) är röda och deras höga 

värden (över målvärdet) markeras med orange. 

1

Rapporten presenteras som en tabell. Överst anges timmarna för 24-

timmarsperioden. Dessutom visas tidsblock för varje måltid.

2

Nere till vänster visas de datum som finns med i den här rapporten. 

Upp till 14 av dagarna visas per rapportsida.

3

I tabellens rader visas uppgifter för varje dag som rapporteras: 

blodsockervärden, bolusar, mängd insulin och kolhydrater.

4

I kolumnen längst till höger ges en sammanfattning för varje dag. Den 

ger ett genomsnitt för alla blodsockervärden och det totala antalet 

kolhydrater som ätits, bolusinsulin som doserats och den totala 

mängden insulin som doserats.

1

2

4

3
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Sensorrapport         

I den här rapporten visas sensoruppgifter, om dessa registrerats. Den 

gör att du kan koppla ihop patientens blodsockerreaktion, kolhydrats-

intaget och bolusaktiviteter.

1

Kurva för blodsockervärde, kolhydrater, insulin

Med hjälp av sensoruppgifterna visar den här kurvan patientens 

blodsockervärden och hur många kolhydrater han eller hon har ätit. 

Dessutom visar den hur många insulinenheter som doserats under 

rapporteringsperioden.

1

2

3 4

5
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2

24-timmars överliggande blodsockerkurva

För varje dag som det finns sensoruppgifter används dessa för att visa 

patientens blodsockervärden för varje dag under rapporterings-

perioden. Dagarna läggs över varandra så att du snabbt kan se om det 

finns något mönster eller inte. De mörkare områdena på kurvan anger 

att det är ett mönster som upprepas under flera dagar.

3

Blodsockervärde nattetid

På grundval av sensoruppgifter visar den här kurvan vad som händer 

med patientens blodsockervärden under natten. Den går från det sista 

blodsockervärdet på en dag fram till det första värdet för nästa dag. 

(Endast om det finns värden tillgängliga för den angivna läggdagstiden 

och den angivna uppvakningstiden.)

4

Överliggande blodsockervärde vid måltider

På grundval av sensoruppgifter visar den här kurvan en överliggande 

bild av patientens blodsockervärden efter varje måltidsperiod. 

Dessutom anges det genomsnittliga antalet kolhydrater som ätits och 

den genomsnittliga mängd insulin som doserats för varje måltid.

5

Statistik

Den här tabellen ger detaljerad statistik och genomsnittsvärden för 

hela rapporteringsperioden.
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Snabböversikt över pumpinställningarna        

Den här rapporten ger en snabböversikt över patientens pump-

inställningar vid ett specifikt datum och en specifik tidpunkt. Det kan 

hjälpa dig att förstå andra rapporter eller helt enkelt dokumentera 

patientens inställningar. 

Pumpinställningarna registreras bara då pumpen avläses. Om pumpen 

inte avlästes under rapporteringsperioden finns inga inställningar 

tillgängliga.
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Daily details report (Dagliga detaljer)        

Daily Detail-rapporten visar uppgifter om pumpen och mätaren samt 

patientens insulinanvändning under en vald dag. Dessutom visar den 

hur många kolhydrater patienten åt. En separat rapport genereras för 

varje dag som valts i datatabellen.

Daily Detail-rapporten ger en detaljerad översikt över alla dagar som 

valts. Den gör att du kan koncentrera dig på en viss dag om du tror att 

det inträffade något intressant för patientens behandling på den 

dagen.

1

Kurva för blodsockervärde, kolhydrater, insulin

Den här kurvan ger en 24-timmars översikt över alla blodsockervärden 

som mätts och hur många kolhydrater om ätits vid varje måltid eller 

mellanmål. Den visar hur många enheter basal- och bolusinsulin som 

doserats. 

2

Bolusdatatabell

Den här tabellen ger detaljerade uppgifter över bolusdata för den 

dagen. Den omfattar en jämförelse mellan doserad bolus och 

rekommenderad bolus.

1

22 3
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3

Statestik

Den här tabellen ger detaljerad statistik och genomsnittsvärden för 

just den här dagen (de första två kolumnerna). Dessutom ger den 

detaljer för hela rapporteringsperioden (de sista två kolumnerna).

Exportera data          

Du kan exportera data från enheten som hämtats och lagrats av 

CareLink Pro. Den ger dig alla uppgifter från patientens enhet så att 

du kan använda dem för statistiken eller för att skapa special-

rapporter eller diagram. Filen (.csv) kan importeras till Microsoft 

Excel eller till vissa kliniska statistikprogram där uppgifterna kan 

bearbetas ytterligare.

Filen (.csv) innehåller uppgifter om enhetens aktiviteter. Den listar 

till exempel registrerade mätarvärden, att pumpen fått ett värde från 

mätaren eller ändringar av basaldosen.

OBSERVERA: Det är en
avancerad funktion som
kräver att du känner till

de rena uppgifterna
från enheten. Dessutom

måste du vara bekant
med den programvara

till vilken du importerar
.csv-filen.

Följ dessa instruktioner för att använda CareLink Pros exportfunktion:

1 Klicka på patientens flik. Eller klicka på knappen Open Patient och 

dubbelklicka på namnet.

2 Kontrollera att arbetsområdet Reports visas.

3 Ställ in datum och längd för rapporten i fälten Duration eller 

Start/End Date.

Den längsta period du kan välja är 12 veckor.

4 Klicka på länken export selected data (exportera valda uppgifter).

länken exportera 
valda uppgifter
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Följande dialogruta visas.

5 Om du vill ändra var .csv-filen ska sparas på din dator ska du klicka 

på pilen till höger om fältet Save in och välja en plats.

6 Om du vill ändra filens namn ska du skriva in det i rutan File name.

7 Klicka på SAVE.
OBSERVERA: Mer

information om de
uppgifter som visas i
CSV-filer finns under
CSV-data, på sidan 86

Nu har .csv-filen sparats på dator, där du valt att den ska sparas. Om 

du vill kan du välja att importera den till ett program som stöttar 

den här filtypen.
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Systemadministration 8

Vad innehåller det här kapitlet?
• Innan du börjar: sida 74

• Programvaruuppdateringar: sida 75

• Säkerhetskopia och återställande av databasen: sida 76

Det är väldigt viktigt att du regelbundet gör en säkerhetskopia av 

CareLink™ Pros databas. I databasen sparas alla systemuppgifter 

som samlats i patientens journaler, inklusive information om 

profilen, uppgifter som härletts från enheten och rapport-

inställningar. 

CareLink Pro låter dig spara kopior av databasen och återställa 

den.

Det är också viktigt att du har den senaste versionen av CareLink 

Pro. Versionerna uppdateras regelbundet och kan innehålla viktiga 

förbättringar. Du kan antingen välja att leta efter uppdateringar 

eller få ett meddelande om när de är tillgängliga.

Innan du börjar

Det är en bra idé att ha ett regelbundet schema för säkerhets-

kopiering av databaserna. På så sätt är du säker på att det görs 

regelbundet och därmed minskar risken för att uppgifter går 

förlorade. 

Under en säkerhetskopiering eller ett återställande detekterar 

CareLink Pro andra användare som kanske använder programmet 
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på andra datorer och ger dem en möjlighet att spara sina arbeten. Vi 

rekommenderar dock att kontrollera om andra användare arbetar på 

systemet innan processen inleds.

Programvaruuppdateringar            

Automatiska uppdateringar

Vid olika tillfällen kommer programvaran till CareLink Pro att 

uppdateras. Gör så här när du får ett meddelande om att det finns en 

uppdatering.

OBSERVERA: Gör en
säkerhetskopia av

databasen innan
programvaran

uppdateras. Se
Säkerhetskopia av en
databas, på sidan 76.

1 Kontrollera att din dator har en aktiv Internetanslutning.

2 Det visas ett meddelande när det finns en uppdatering av CareLink 

Pro.

3 Klicka på DOWNLOAD. Följande varning visas.

4 Klicka på YES för att skapa en säkerhetskopia av databasen (se 

Säkerhetskopia av en databas, på sidan 76 för proceduren). Klicka 

på NO om du inte vill göra någon säkerhetskopia.

Den nya versionen av CareLink Pro hämtas när du ser följande 

meddelande:
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5 Klicka på YES för att stänga och öppna programvaran på nytt om du 

vill börja använda den senaste versionen av CareLink Pro. Klicka på 

NO om du hellre vill vänta innan du startar om CareLink Pro.

Avstängning av automatiska uppdateringar

Gör så här om du inte vill få något automatiskt meddelande om 

uppdateringar av CareLink Pro:

1 Välj Tools > Options.

2 Klicka på fliken General.

3 Avmarkera rutan bredvid Automatically check for software updates i 

avsnittet Communications.

Manuell kontroll av uppdateringar

Du kan när som helst manuellt kontrollera om det finns några 

uppdateringar av CareLink Pro:

OBSERVERA: Gör en
säkerhetskopia av

databasen innan
programvaran

uppdateras. Se
Säkerhetskopia av en
databas, på sidan 76.

1 Kontrollera att din dator har en aktiv Internetanslutning.

2 Välj Tools > Check for Software Updates

3 Du får ett meddelande som talar om ifall det finns några 

uppdateringar eller inte. Om det finns en uppdatering visas följande 

meddelande:

4 Följ procedurerna under Automatiska uppdateringar, på sidan 75.

Säkerhetskopia och återställande av databasen

Säkerhetskopia av en databas     

Gör så här för att göra en säkerhetskopia av databasen.

1 Kontrollera att alla patientjournaler är stängda.

2 Välj Tools > Backup Database.
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OBSERVERA:
Säkerhetskopior kan

sparas på en
nätverksstation eller på

ett uttagbart
lagringsmedium (DVD,

CD, USB-stick etc.)

3 Om du vill spara en säkerhetskopia på en annan plats på din dator 

ska du klicka på pilen till höger om fältet Save in och välja en ny 

plats.

4 Om du vill ändra filens namn ska du skriva in det i rutan File name.

5 Klicka på SAVE. En förloppsindikator visas.

När säkerhetskopieringen har slutförts visas följande dialogruta.

6 Klicka på OK.

Återställa en databas   

Det kan hända att databasen måste bytas ut om den inte längre kan 

öppnas eller användas. Ju nyare din säkerhetskopia är, desto färre 

uppgifter går förlorade om du måste ersätta databasen.

VARNING! Kontrollera att den befintliga databasen verkligen inte går att använda innan du 
byter ut den. När du byter ut den mot en säkerhetskopia går alla uppgifter som skapats 
efter den valda säkerhetskopian förlorade.

Gör så här för att välja en säkerhetskopia som ska ersätta den 

aktuella databasen.

1 Kontrollera att alla patientjournaler är stängda.

2 Välj Tools > Restore Database. 

3 Gå till fältet Look in och välj från vilken plats du vill kopiera 

säkerhetskopian av databasen.

4 Välj den säkerhetskopia du vill använda för att ersätta den aktuella 

databasen (oftast den senaste).
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5 Klicka på OPEN. Ett varningsmeddelande visas för att påminna dig 

om att alla uppgifter kan gå förlorade om du fortsätter med åter-

ställandet av databasen.

6 Klicka på OK för att fortsätta. En förloppsindikator visas.

När återställningen har slutförts visas följande dialogruta.

7 Klicka på OK.

Lås databasen                 

Om du säkerhetskopierar eller återställer databasen varnas du om det 

är någon som använder programvaran på en annan dator. Du 

uppmanas att inleda en procedur som tillfälligt låser databasen.

1 Om någon annan använder programvaran då du börjar säkerhets-

kopiera eller återställa databasen visas ett meddelande.

2 Gör något av följande:

– Välj YES för att låsa databasen tillfälligt. Alla aktiva användare 
får en varning som talar om att programvaran stängs om 20 
sekunder och att de måste spara deras arbete. Om någon annan 
användare annulerar låsningen får du en varning av program-
varan. Klicka i så fall på OK och försök igen senare.

– Välj NO för att stoppa låsningen och låta alla andra aktiva 
användare fortsätta.
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Reagera på ett meddelande om att databasen ska låsas                 

1 Om en annan användare försöker säkerhetskopiera eller återställa 

databasen när du använder programvaran visas ett meddelande som 

varnar dig om detta.

2 Gör något av följande:

– Klicka på OK för att tillåta avbrottet. 

– Välj CANCEL så att programmet inte stängs av. Det gör att du kan 
avsluta en viktig arbetsuppgift. 

Om systemet inte är tillgängligt                

Om du försöker använda systemet kan det hända att du får ett 

meddelande som anger att systemet inte är tillgängligt. Det innebär 

att en annan användare säkerhetskopierar eller återställer databasen. 

Inga andra kan komma åt systemet innan den uppgiften har slutförts.

Gör något av följande:

• Vänta tills processen är färdig och systemet är tillgängligt igen.

• Klicka på CANCEL för att avsluta och försöka igen senare.
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Felsökning 9

Vad innehåller det här kapitlet?
• Allmänna fel: sida 80

• Fel vid avläsning av enheten: sida 81

• Fel då rapporten skapas: sida 82

• Säkerhetskopiering och återställande av fel: sida 83

• Avinstallera programvaran: sida 83

Det här kapitlet hjälper dig att lösa problem som kan uppstå då du 

använder programvaran till CareLink™ Pro. Dessutom innehåller det 

instruktioner om hur programvaran till CareLink Pro ska 

avinstalleras om det skulle behövas.

Allmänna fel

Rätt att hämta uppdateringar av programvaran från Internet

Om du försöker hämta en uppdatering av programvaran från 

Internet kan det hända att du får ett meddelande om att du inte 

är auktoriserad att göra det. Du måste ha administratörsstatus för 

att få hämta uppdateringar av programvaran till CareLink Pro.

1 Stäng CareLink Pro och starta om datorn. 

2 Be någon med administratörsstatus logga in på datorn.

3 Följ instruktionerna under Programvaruuppdateringar, på 

sidan 75.
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Inte ansluten till databasen

Ett felmeddelande som anger att du inte är ansluten till databasen 

innebär något av följande:

• Databasen har flyttats. Databasen måste vara på samma plats som 

valdes då programvaran till CareLink Pro installerades. Om den har 

flyttats måste den flyttas tillbaka till den plats som valdes under 

installationen.

• Du är inte ansluten till den nätverksstation där databasen ligger. Om 

databasen ligger på en nätverksstation kan det hända att nätverket 

har vissa problem som gör att du inte kan komma åt stationen. Du är 

inte ansluten till den nätverksstation där databasen ligger. 

Glömt klinikens lösenord till CareLink Pro

Om ingen kommer ihåg det lösenord som kliniken använder för att 

logga in till CareLink Pro är den enda lösningen att programvaran till 

CareLink Pro installeras på nytt och att ni skapar en ny databas.

Fel vid avläsning av enheten

Fel vid avläsning av enheten Förklaring

Den seriella port som valdes 
kan inte öppnas. Det kan 
hända att en annan handling 
utförs på den porten. Vänta 
tills porten blir ledig eller 
välj en annan port.

Bekräfta att kommunikationsporten inte används 
av något annat program eller välj en annan port. 
Försök att starta om datorn och sedan försöka 
läsa av igen. Det kan vara något fel på den 
maskinvara (kabel etc.) som anslutits till porten 
eller ett fel på själva porten. Anslut maskinvaran 
till en annan port och försök läsa av enheten 
igen, för att avgöra om det var problemet. 

Auto Detect hittade inte 
enheten på någon tillgänglig 
port. Kontrollera kabel-
anslutningen, enhetens 
batteri & status och försök 
igen, eller försök specificera 
en seriell port.

Kontrollera anslutningen mellan kabeln och 
datorn samt att batteriets status är OK. Om dessa 
är bra, pröva att specificera den seriella port på 
datorn som kabeln anslutits till, i stället för att 
välja Auto Detect.

Enheten hittas inte i den 
seriella port som valts. 
Kontrollera kabel-
anslutningen, enhetens 
batteri & status och försök 
igen, pröva med att 
specificera en annan port 
eller pröva med Auto Detect.

Kontrollera anslutningen mellan kabeln och 
datorn samt att batteriets status är OK. Om dessa 
är bra, pröva antingen att välja en annan seriell 
port på datorn eller välj alternativet Auto Detect.
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Fel då rapporten skapas

Flera uppgifter för samma datum

Om det finns flera uppgifter för samma datum och tid för samma 

enhet så betraktar systemet det som en konflikt som inte kan lösas. 

Rapporter som skapas med dessa uppgifter utelämnar den del av 

uppgifterna som överlappar varandra. 

Du kan försöka anpassa rapporteringsperioden så att de överlappande 

uppgifterna utelämnas. Eller så kan du ta bort enheten från systemet 

och sedan lägga till den igen så att de tidigare avläsningarna raderas.

Kan inte kommunicera med 
enheten. Kontrollera att du 
har satt i och valt rätt enhet, 
kontrollera kabel-
anslutningen, enhetens 
batteri och status och försök 
igen.

Kontrollera alla inställningar som valts för 
avläsning av enheten, inklusive enhetens namn, 
serienummer och typ av anslutning. Kontrollera 
även att enheten, kablarna och datorn är 
anslutna på rätt sätt. Kontrollera att enhetens 
batteri- och alarmstatus är OK. Försök läsa av 
igen.

Oväntad respons... försöker 
igen (n%)

Ett oväntat värde lästes av från enheten. 
Systemet försöker återuppta kommunikationen 
tills det att du annulerar eller tills 
kommunikationen lyckas.

Länkenheten hittades, men 
pumpen (<serienummer>) 
reagerar inte. Bekräfta 
pumpens serienummer, 
placera pumpen närmare 
länkenheten för minimal 
störning, kontrollera 
pumpens batteri och status.

Kontrollera att rätt serienummer förts in för 
pumpen. Om inte, för in rätt serienummer. Om 
serienumret är korrekt kan du försöka flytta 
pumpen närmare Paradigm Link Monitor, eller 
flytta bort Paradigm Link Monitor och pumpen 
från möjliga störningskällor (som andra RF-
enheter) eller kontrollera pumpens batteri och 
doseringsstatus.

Pumpen doserar en temporär 
basaldos. Annulera den 
temporära basalen eller 
vänta tills den är slutförd 
och försök sedan på nytt.

Den pump du försöker läsa av doserar en 
temporär basaldos. Vänta antingen med att 
avläsa pumpen tills den temporära basaldosen är 
avslutad eller annulera den temporära basaldosen 
och läs sedan av pumpen.

Pumpen har aktiva fel eller 
alarm. Radera alarmen och 
försök på nytt.

Det finns aktiva alarm på pumpen som gör att den 
inte kan läsas av. Läs igenom alarm-
instruktionerna och radera alarmet. Radera 
alarmet och försök läsa av pumpen på nytt.

Pumpen doserar en bolus. 
Annulera bolusen eller vänta 
tills den är slutförd och 
försök sedan på nytt.

Den pump du försöker läsa av doserar en bolus. 
Vänta antingen med att avläsa pumpen tills 
bolusen är avslutad eller annulera bolusen och läs 
sedan av pumpen.

Enheten skickar ogiltiga 
uppgifter; alla avlästa 
uppgifter kasseras.

Kontakta produktsupporten i ditt hemland (se 
Hjälp, på sidan 3). 

Fel vid avläsning av enheten Förklaring
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Systemet kommer att ignorera uppgifterna

Om tiden på en enhet har ändrats så att det ger överlappningar eller 

utelämnade uppgifter på tre timmar eller längre tar inte systemet 

med de uppgifterna då rapporterna skapas.

Säkerhetskopiering och återställande av fel

Databasen kan inte låsas

Det innebär att du använder systemet i en miljö med flera användare 

och att andra användare var inloggade. Systemet tillåter inte en 

säkerhetskopiering av databasen samtidigt som andra användare kan 

utföra uppgifter som kan påverka databasen. Efter att alla andra 

användare har lämnat CareLink Pro kan du göra en säkerhetskopia.

Säkerhetskopieringen eller återställandet av databasen slutförs inte

Andra användare kan inte logga in och säkerhetskopieringen eller 

återställandet kan inte slutföras. Kontakta produktsupporten i ditt 

hemland (seHjälp, på sidan 3).

Återställandet av databasen misslyckas

Det är något fel på den säkerhetskopia av databasen som du försöker 

använda för återställandet. Försök återställa med en annan 

säkerhetskopia.

Avinstallera programvaran

Gör så här för att avinstallera CareLink Pro:

1 Öppna menyn Control Panel through your Windows Start.

2 Välj Add or Remove Programs. Följande fönster visas.
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3 Bläddra ner till Medtronic Carelink Pro och klicka på den.

4 Klicka på REMOVE. Installationsguiden visas.

5 Klicka på NEXT. Följande meddelande visas:

6 Klicka på YES. Avinstallationsprogrammet körs och tar bort 

programmet och alla dess filer från din dator. När det är färdigt visas 

följande meddelande på skärmen för att bekräfta avinstallationen.

7 Klicka på FINISH.
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Symboltabell
Ikonerna och symbolerna på förpackningsetiketten och utrustningen 

beskrivs i följande tabell.

Beskrivning Ikon

En per behållare/förpackning (1st.)

Obs: Se bruksanvisningen

CD medföljer

Viktiga dokument bifogade

Referensnummer REF

CE-märkning av anmält organ som 
medicinteknisk produkt
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Bi
la

ga
 A

CSV-data A

I den här bilagan definieras kolumnerna i de CareLink™ Pro-

uppgifter som du ser då du exporterar till CSV-format. Dessutom 

innehåller den annan information du kan behöva om CSV-filer. 

OBSERVERA: Alla
uppgifter är det som

registrerades i enheten
på det angivna datumet

vid den tiden.

Definition av kolumnerna

Läs igenom tabellen så blir det lättare att förstå vilken typ av 

uppgifter som finns med i de olika kolumnerna.

Kolumnrubrik Definition

Index Den ordning i vilken uppgifterna registrerades i 
enheten.

Date (Datum) Den ordning i vilken datumen registrerades i 
enheten.

Time (Tid) Den ordning i vilken tiden registrerades i 
enheten.

New Device Time (Ny tid i 
enheten)

Det nya datumet och den nya tiden om det har 
ändrats i enheten.

BG Reading (mg/dl or 
mmol/l) (BS-värde (mg/dl 
eller mmol/l))

Det blodsockervärde som registrerats av mätaren 
eller pumpen. Om uppgifterna kommer från en 
pump är värdena i kolumnen manuella BS-värden 
och BS-värden från Paradigm Link-mätaren. 

Linked BG Meter ID (ID för 
länkad BS-mätare)

Serienumret på den mätare som skickar 
blodsockervärden till enheten.

Basal Rate (U/h) (Basaldos 
(E/tim))

Den aktiva basalinsulindosen i enheter per 
timme.

Temp Basal Amount (Temp 
basalmängd)

Om en temporär basaldos användes i pumpen 
anger det här värdet den mängden (ny insulindos 
eller procent av basaldosen). 

Temp Basal Type (Temp 
basaltyp)

Inställningen för den temporära basaldosen 
(insulindos eller procent av basaldosen).
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Temp Basal Duration (m or%) 
(Temp basal varaktighet (m 
eller %))

Tidslängden i minuter eller procent för den 
temporära basalinsulindoseringen (se typen 
ovan).

Bolus Type (Bolustyp) Doseringstyp för bolusinsulin [normal, förlängd, 
dubbel (normal del) eller dubbel (förlängd del)].

Bolus Volume Selected (U) 
(Vald bolusvolym (E))

Antalet insulinenheter som valts att doseras 
under bolusinsulindosering.

Bolus Volume Delivered (U) 
(Doserad bolusvolym (E))

Antalet insulinenheter som verkligen doseras 
under bolusinsulindosering.

Extended Bolus Duration (h) 
(Förlängd bolusvaraktighet 
(tim))

Varaktighet för den förlängda delen av en 
förlängd bolus eller en dubbel bolus.

Prime Type (Primetyp)

Primetypen—manuell eller fast. Manuell används 
omedelbart efter en återställning, för att fylla 
infusionssetet med insulin innan det sätts in. Fast 
används efter att infusionssetet satts in för att 
fylla den mjuka kanylen med insulin efter att 
mandrängen har tagits ut.

Prime Volume Delivered (U) 
(Doserad primevolym (E))

Antalet insulinenheter som verkligen doseras för 
primen.

Alarm Namnet på det alarm som gått.

Suspend (Stoppa) Anger “Suspended” när pumpen har stoppats och 
“Resumed” när den har startat igen.

Rewind (Återställ pump) Återställer händelsen vid det datum och den tid 
som enheten avlästes.

BWZ Estimate (U) 
(Bolusguide beräkning (E))

En uppskattning av bolusinsulinet om det 
beräknats med funktionen bolusguide på 
Paradigmpumpen.

BWZ Target High BG (mg/dL 
or mmol/L) (Bolusguide högt 
BS (mg/dl eller mmol/l))

Paradigmpumpens inställning för det högre 
gränsvärdet för blodsocker, inställt med 
funktionen bolusguide.

BWZ Target Low BG (mg/dL 
or mmol/L) (Bolusguide lågt 
BS (mg/dl eller mmol/l))

Paradigmpumpens inställning för det lägre 
gränsvärdet för blodsocker, inställt med 
funktionen bolusguide.

BWZ Carb Ratio (Bolusguide 
kolh.kvot)

Paradigmpumpens inställning för insulin-
kolhydratkvoten. Om enheten gram används är 
denna kvot mängden kolhydrater i gram som täcks 
av en enhet insulin. Om enheten utbyten används 
är denna kvot det antal insulinenheter du behöver 
för att täcka ett kolhydratutbyte. Detta ställs in 
av funktionen Bolusguide.

BWZ Insulin Sensitivity 
(Bolusguidens 
insulinkänslighet)

Paradigmpumpens inställning för 
insulinkänsligheten. Insulinkänsligheten är den 
mängd blodsockervärdet minskas med av en enhet 
insulin. Detta ställs in av funktionen Bolusguide.

BWZ Carb Input (Bolusguide 
kolh.kons.)

Värdet för den förväntade kolhydratkonsumtionen 
när funktionen Bolusguide används på 
Paradigmpumpen för att beräkna en bolus.

BWZ BG Input (mg/dL or 
mmol/L) (Bolusguide BS-
inmatn. (mg/dl eller 
mmol/l))

Inmatningen för blodsockervärdet när funktionen 
Bolusguide används på Paradigmpumpen för att 
beräkna en bolus.

Kolumnrubrik Definition
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Mer om CSV-filer

Titeln överst i en CSV-fil innehåller följande information:

• patientens namn

• en lista med valda enheter och deras serienummer

• valda datum

Varje block med kolumner har en titel som innehåller det följande:

• namnet på den enhet uppgifterna gäller för

• serienumret på den enheten

Om uppgifterna inte visas som förväntat

Det är flera olika faktorer som kan göra att CSV-uppgifterna visas på 

ett annat sätt än förväntat. Några av dessa faktorer anges nedan:

• Ändringar av datum eller tid på enheten kan antingen ändra 

sekvensen eller ge registreringar utanför det valda datumområdet.

• Om det är en stor lucka mellan avläsningar av enheten kan det hända 

att uppgifterna för den enheten visas i flera block.

BWZ Correction Estimate (U) 
(Bolusguide korrektions-
beräkning (E))

Det beräknade antalet enheter bolusinsulin som 
ska ges för att korrigera blodsockervärdet, 
beräknat av funktionen Bolusguide.

BWZ Food Estimate (U) 
(Bolusguide matberäkning 
(E))

Det beräknade antalet enheter bolusinsulin för 
att täcka det förväntade kolhydratintaget, 
beräknat av funktionen Bolusguide.

BWZ Active Insulin (U) 
(Bolusguide aktivt insulin 
(E))

Mängden aktivt insulin som beräknats ska finnas 
kvar i kroppen från tidigare bolusinsulindoser när 
bolusmängden ska beräknas med funktionen 
Bolusguide.

Sensor Calibration BG 
(mg/dL or mmol/L) 
(Sensorkalibrering BS (mg/dl 
eller mmol/l))

Det BS-värde som används för kalibrering av 
sensorn i mg/dl eller mmol/l

Sensor Glucose (mg/dL or 
mmol/L) (Sensor-BS (mg/dl 
eller mmol/l))

Sensorns kalibrerade blodsockervärde.

ISIG value (ISIG-värde) ISIG-värdet som lästs av från pumpen.

Kolumnrubrik Definition
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O
rd

li
st

a

Ordlista

A
A1c   Glykosylerat hemoglobin

A1c-test  Hemoglobin A1c-test, som används för att tolka blodsocker-
värdena under en tidsperiod.

B
Basaldos  Pumpinställning som ger löpande insulininfusion för att 
hålla blodsockret stabilt mellan måltiderna och under natten. Basalt 
insulin efterliknar bukspottkörtelns insulindosering vilket motsvarar 
kroppens icke-matrelaterade insulinbehov.

Basalinsulin  En kontinuerlig mängd insulin per timme som doseras 
automatiskt av insulinpumpen, grundad på förprogrammerade profiler 
för personliga doser som ställts in i pumpen. Pumpen doserar en 
daglig mängd insulin som normalt sett täcker "bakgrundsbehovet" av 
insulin under perioder med fasta (t.ex. nattetid och mellan mål-
tiderna.

Basalprofil  En basaldos med en start- och en stopptid. Användaren 
kan programmera in flera olika profiler i sin pump, var och en med sin 
egen basaldos, under en 24-timmarsperiod, för att få bättre glukos-
kontroll.

Basalprogram  Användaren kan programmera upp till tre olika 
basalprogram i pumpen för dosering av basalinsulin: Standard, A och 
B. Varje program har möjligheten att ställa in upp till 48 basaldoser.

Bolusinsulin  En dos insulin som doseras för att täcka en förväntad 
höjning av blodsockret (som t.ex. höjningen efter en måltid eller ett 
mellanmål) eller för att sänka ett högt blodsocker ner till målvärdet.

BS  Blodsocker

C
CareLink® Personal  En onlinetjänst som kan hantera diabetes-
uppgifter via Internet.
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ComLink  En radiofrekvensenhet (FR) med sändare och mottagare 
som används för att hämta uppgifter från Paradigmpumpen till 
datorn.

Com-Station  En enhet som används för att hämta uppgifter från 
pumpen MiniMed 508 och vidarebefordra uppgifter från andra 
tillverkares mätare till datorn.

D
Dubbel bolus (Dual Wave®)  En kombination av normal bolus som 
doseras omedelbart och därefter följs av en förlängd bolus. Förlängd 
bolus doserar jämnt under en period.

E
Expressbolus  En tillsatsmetod för valfri bolustyp som använder sig av 
pumpens express bolus-knapp.

F
Fältet under kurvan  Anger mängden för höga och låga avvikelser, 
vilka fastställs av de förinställda värdena. Avvikande uppgifter anger 
hur ofta värdena var för höga eller för låga. Fältet under kurvan anger 
händelsernas omfattning genom att visa hur långt utanför värdena de 
låg och hur länge.

Förlängd bolus (Square Wave®)  En bolus som doseras jämnt över en 
period (från 30 minuter till 8 timmar). 

Förlängd del  Den andra delen i en dubbel bolus. Den förlängda delen 
doserar jämnt över en period sedan NU-delen doserats.

G
Genomsnittlig absolut procentuell skillnad (MAD, Mean Absolute 
Percent Difference)  Anger hur pass noggrann kalibreringen av 
sensorn är i förhållande till mätarvärdena. Ju lägre siffra, desto 
noggrannare kalibrering. MAD beräknas med hjälp av skillnaden 
mellan närliggande uppsättningar sensor- och mätarvärden, delat 
med mätarvärdena följt av ett medelvärde för alla par.

H
HbA1c   Glykosylerat hemoglobin

HbA1c-test  Hemoglobin A1c-test, som används för att tolka blod-
sockerkontrollen eller genomsnittet av värdena under en period på
2-3 månader.

Hyperglykemisk  Förhöjt blodsocker som upptäcks vid övervakningen 
av blodsockervärdena, med eller utan något eller alla av de följande 
symptomen: illamående, kräkningar, suddig syn, huvudvärk, orolig 
mage, att kissa ofta och stora mängder samt apati. 
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Hypoglykemisk  Lågt blodsocker som upptäcks vid övervakningen av 
blodsockervärdena, med eller utan något eller alla av de följande 
symptomen: extrem hunger, skakningar elller darrningar, svettning, 
"dansande" syn, yrsel, huvudvärk, sluddrande tal, plötsliga humör-
byten eller personlighetsförändringar.

Högt BS  Pumpen utlöser ett alarm om sensorn indikerar att 
användarens sensorblodsocker är lika med eller över detta värde. Du 
kan aktivera eller inaktivera den här funktionen som du vill.

I
Infusionsset  Den apparat som används för att föra in och säkra en 
kanyl under huden och transportera insulin till insticksstället genom 
slangar från pumpen.

Insulinkoncentration  Styrkan eller typen av insulin som läkaren 
skrivit ut åt användaren. Detta påverkar den insulindos som pumpen 
doserar. Om användarens insulinkoncentration ändras måste basal-
profilerna och de maximala basal- och bolusdoserna programmeras 
om i pumpen.

Insulinkänslighet  Hur mycket i mg/dl (eller mmol/l) din 
blodsockernivå (BS-nivå) förändras av en enhet insulin. 
(Bolusguidedata.)

ISIG  Sensorvärden som anger om sändarens elektronik i ett 
sensorförstärkt system fungerar korrekt. Om du ser ett ISIG-värde som 
är mindre än 24,00 nA eller större än 29,00 nA ska du kontakta 
produktsupporten. Det kan vara dags att byta ut din sändare. 

K
Kal.påmin.  Pumpen utlöser automatiskt alarmet BS per TT:MM var 
12:e timme som talar om att det aktuella kalibreringsvärdet inte 
längre är giltigt. Tiden för kalibreringspåminnelsen kan ställas in 
efter eget val så att användaren påminns om kalibreringen. Om 
kalibreringspåminnelsen till exempel är inställd på 2 timmar, utlöses 
alarmet BS per TT:MM 2 timmar innan kalibreringen måste göras.

Ketontest  Ketoner är en avfallsprodukt som produceras när kroppen 
tvingas att förbränna kroppsfett i stället för blodsocker för att få 
energi. Det kan vara ett tecken på insulinbrist i kroppen. Ketontestet 
mäter ketonkoncentrationen i blodet eller urinen.

KH  Kolhydrater

Kolhydratenheter  Matintag med Bolusguide. Förs in som (kolhydrat) 
gram eller utbyten.

Kolh. kvot (Kolhydratkvot)  Den mängd kolhydrater som täcks av en 
enhet insulin. (Se även utbyteskvot).

Korrektionsbolus  Den mängd insulin som behövs för att få ned den 
höga blodsockernivån till målvärdet.
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Korrektionsbolusfaktor (känslighetsfaktor)  Hur mycket 1,0 enhet 
insulin sänker blodsockret. Denna faktor används för att beräkna en 
korrektionsbolusmängd när blodsockret är högt.
(BS-nivå) – (BS-mål) = X.
X ÷ (korrektionsbolusfaktor) =
korrektionsbolus

L
Ljudbolus (Easy Bolus™)  Doseringsmetod för en normal bolus som 
använder Easy bolus-knappen på pumpen.

Ljudbolus  Pumpen kan programmeras så att användaren hör en 
signal när de väljer en bolusinsulinmängd (0,5 eller 1,0 enheter) som 
ska doseras. Den här funktionen är praktisk i lägen där det är svårt att 
se knapparna på pumpen.

Lågt BS  Pumpen utlöser ett alarm om sensorn indikerar att 
användarens sensorblodsocker är lika med eller under detta värde. Du 
kan aktivera eller inaktivera den här funktionen som du vill.

Länk  Att sätta på och koppla upp mätarfunktionen, som gör att 
pumpen kan ta emot BS-värden från Paradigm Link-mätaren.

Termen används även i det här systemet som hänvisning till hyper-
textlänkar. Om du klickar på en hypertextlänk kommer du till ett 
annat ställe i systemet eller till en annan hemsida.

M
Manuell bolus  Valbar funktion i BOLUSMENYN när Bolusguiden är 
aktiv. En metod att programmera en bolus utan Bolusguide. 

Max basalinsulin  Den maximala mängd basalinsulin som pumpen är 
inställd på att dosera per timme. (ställs in av användaren)

Max bolus  Den maximala mängd bolusinsulin som pumpen är inställd 
på att dosera per timme. (ställs in av användaren)

Måltidsbolus  En dos insulin som doseras för att täcka den förväntade 
höjningen av blodsockret efter en måltid.

Mätaralternativ  Funktion som gör att pumpen tar emot BS-värden 
från en länkad blodsockermätare.

Mätare  Ett medicinskt instrument som avgör det ungefärliga 
blodsockervärdet i blodet. En liten droppe blod läggs på en 
testremsa, som mätaren sedan läser av och använder för att beräkna 
blodsockervärdet. Mätaren visar sedan värdet i mg/dl eller mmol/l.   

N
Normal bolus  En omedelbar dosering av en specificerad mängd 
insulin. 
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P
Program, standard  Din normala basaldos för dina dagliga aktiviteter. 
När programfunktionen är avstängd, använder pumpen ditt standard-
(basal)program.

Programfunktion  En pumpfunktion som låter dig programmera 
valfria basaler (Program A, Program B) som uppfyller insulinbehov för 
aktiviteter eller blodsockermönster som inte är en del av dina dagliga 
rutiner, men som ändå förekommer i din livssituation. Det kan t.ex. 
vara en idrottsaktivitet som du utför en gång per vecka, ändrade 
sovvanor under veckosluten eller hormonförändringar under 
menstruationen. 

R
RF  Radiofrekvens (RF) 

S
Steg  Inställda antal enheter insulin per knapptryckning vid 
Ljudbolus-dosering.

Stoppa  En funktion hos pumpen som stoppar all insulindosering. Alla 
pågående bolus- och/eller primedoser avbryts. Basaldoseringen 
avbryts temporärt tills den återstartas. 

Sändar-ID  Serienummer på den sändare som för tillfället används.

T
Temp  Temporär

Temporär basal  Temporär dosering av basalinsulin av engångstyp 
med en specificerad mängd och varaktighet. Används för att fylla 
insulinbehov för speciella aktiviteter och situationer som inte tillhör 
de normala, dagliga rutinerna.

U
μl  Mikroliter  
Utbyteskvot  Den mängd insulin som behövs för att täcka ett (1) 
kolhydratutbyte. (Se även kolhydratkvot).

V
Varning för låg reservoarvolym  Programmerbar varning, som 
antingen uppmärksammar dig på att ett specificerat antal enheter 
finns kvar i pumpreservoaren eller att en specificerad tid återstår 
innan reservoaren är tom.

Ö
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Överföra  Processen att föra över uppgifter från pumpen eller 
mätaren till CareLink™ Personals server.
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